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Overview

This installation guide provides instructions for installing, updating, and uninstalling IBM® Rational®

Asset Manager.

You can find the most recent version of this Installation Guide online at http://
download.boulder.ibm.com/ibmdl/pub/software/rationalsdp/v7/ram/7111/docs/install_instruction/
install.html.

Before installing, you should consult the release notes for late-breaking installation issues. The release
notes file is available online at: http://download.boulder.ibm.com/ibmdl/pub/software/rationalsdp/v7/
ram/7111/docs/readme/readme.html,

Note: Refer to http://www.ibm.com/software/rational/support/documentation/ for updated
documentation and troubleshooting information.
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Planning your installation

This section discusses the two basic installation configurations for the Rational Asset Manager server and
provides some points to consider before beginning the installation process.

Installation scenarios

Rational Asset Manager offers four basic installation scenarios.
v Upgrading from an existing version of Rational Asset Manager.
v Installing Rational Asset Manager V7.1.1 on a new instance of embedded WebSphere® Application

Server V6.1
v Installing Rational Asset Manager V7.1.1 on an existing installation of WebSphere Application Server

V6.1
v Manually installing Rational Asset Manager V7.1.1 on a supported version of WebSphere Application

Server or Apache Tomcat.

For any of these scenarios, you can optionally install the Rational Asset Manager Eclipse client to interact
with the repository.

Disk considerations for optimizing performance

To achieve the best performance possible, plan to separate the database, repository index, temporary
folders, and assets directory on separate hard disk drives. This will help prevent certain operations (for
example, asset retrieval, or the indexing of assets in the repository) from interfering with the performance
experienced by users performing different operations (for example, asset browsing).

Database

Rational Asset Manager requires a database for asset and data storage. To improve performance, the
database server typically is on a separate physical machine from the application server and on a
dedicated disk.

The user who configures the database tables and schema must have database administrator privileges.

Application server

If using WebSphere Application Server, you can choose to install a new embedded WebSphere
Application Server, or use your existing version of WebSphere Application Server. Either server may be
used in conjunction with any database or other platform software.

Embedded WebSphere Application Server is a lightweight version of the server. It is intended to support
environments that run a limited number of applications and do not require the full administration
support provided by WebSphere Application Server. The embedded WebSphere Application Server
provides a lightweight version of the WebSphere Application Server administration console with limited
configurability.

User registries

Although Rational Asset Manager supports adding users from an external registry (such as LDAP or a
custom registry), it is not necessary to use an external registry. Users can be added manually.

Security and user authentication
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If you plan to manually install Rational Asset Manager onto an existing WebSphere Application Server
that is already configured for security (for example, using LDAP), reconfigure the application server for
file-based security until the installation and configuration of Rational Asset Manager is complete. After
installing and configuring the server application to use a custom user registry, you can restore WebSphere
Application Server security configuration. For details, see “Configuring file-based security” on page 50.

File-based security is not intended for use in production environments.

Integrations

Optionally, you can integrate with Rational ClearQuest®, Rational ClearCase®, and WebSphere Service
Registry and Repository. Client applications must be installed on the same machine as the server and
Rational Asset Manager server application. To improve performance, the servers for these applications
typically will reside on machines other than the application server.

When integrating with Rational ClearCase, the WebSphere Application Server service must be started as
the same user who has access to the versioned object base (VOB).

Clusters

When you deploy Rational Asset Manager to a cluster environment, the components must be
homogenous with regard to operating system and application server. If you plan to integrate with
Rational ClearCase and Rational ClearQuest, client applications must be installed on every component in
the cluster, and must have the same installation path on every node in the cluster. Individual nodes
cannot be configured independently

Large numbers of assets

If you expect that the repository will contain a large number of assets (for example, tens or hundreds of
thousands), note that several asset management operations, such as indexing, might require several
hours. There are data management and hard-disk management techniques that might improve
performance under such conditions, such as using a Redundant Array of Independent Disks (RAID) and
a technique called disk striping. Disk striping involves dividing data into blocks and storing the data
blocks on multiple partitions on multiple hard disk drives. See the documentation for your operating
system for instructions about how to set this up for your environment. Also, as mentioned in the
previous paragraph, consider placing the repository index, assets and database each on a different hard
disk.
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Rational Asset Manager installation scenarios

This section discusses the steps to upgrade IBM Rational Asset Manager, to install it with embedded
WebSphere Application Server V6.1, and to install it to an existing installation of WebSphere Application
Server or Apache Tomcat server.

Upgrading from a previous version of Rational Asset Manager
This outline lists the steps you must complete in order to upgrade from an earlier version of IBM
Rational Asset Manager.

Before you begin

If you have Internet access, you can use Installation Manage to locate and install the updates directly
from the IBM update repository for Rational Asset Manager.

Important: When Rational Asset Manager installs, the location of its update repository is automatically
embedded in Installation Manager. For Installation Manager to search the default update repository, the
Search the linked repositories during installation and updates preference on the Repositories
preferences page must be selected; this preference is selected by default.

To install the fix pack from a different repository location (for example, if the update is on a shared drive
or HTTP or HTTPS server), add the repository location in Installation Manager. To add a repository
location, see “Setting repository preferences in Installation Manager” on page 93.

To work with Installation Manager for AIX®, you must use a graphical user interface (GUI). If you do not
access to a GUI, you must either emulate one with VNC or investigate installing silently over the
command line with response files. For more information, see the IBM Installation Manager online help.

Procedure

1. Create a backup of your Rational Asset Manager database. For more information, see the
documentation for your database software.

2. If you use WebSphere Application Server, create a backup of your server configuration by using the
<WebSphere-Install-Directory>\bin\backupConfig.bat command. For more information, see the
WebSphere Application Server documentation.

3. If you use the embedded WebSphere Application Server, stop the embedded WebSphere Application
Server. If issuing the Rational Asset Manager Stop the server command does not stop the server, run
the stopServer command from a command line in the <Install-directory>\ram\ewas\bin directory,
and specify a server administrator user name and password using the -username and -password
options.

4. Retrieve the appropriate Rational Asset Manager applications:
v If you use Windows®, Linux®, or AIX, and you used IBM Installation Manager to install

Rational Asset Manager or to retrieve the application files, use Installation Manager for the
upgrade process. See the instructions “Retrieving the Rational Asset Manager server application
for Windows, Linux, or AIX from the installation media with Installation Manager” on page 46
and note the following differences:
a. Start IBM Installation Manager. On Windows Vista, you must run Installation Manager as an

administrator (Right-click the program shortcut and select Run as administrator.
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b. Installation Manager might need to update itself to a later version to upgrade Rational Asset
Manager. To configure Installation Manager so that it checks for updates: on the Start page
click File → Preferences; then, click Updates. In the Updates page, select Search for
Installation Manager updates.

c. On the Start page of Installation Manager, click Update.
d. On the Update Packages page, select IBM Rational Asset Manager; then, click Next. Expand

and select the latest version of Rational Asset Manager server and click Next.
e. Follow the instructions in the Update Packages wizard. If you use WebSphere Application

Server, on the Context Root page of the Features section, Installation Manager will detect the
context roots for your current Rational Asset Manager applications. Note the context root for
Rational Asset Manager Setup Server; you will need to know the context root to access the
server setup application.

f. After the update process finishes:
1) If you use the embedded WebSphere Application Server, all .ear files have been updated.

Start the embedded WebSphere Application Server and log on to the Rational Asset
Manager Web client as an administrator. Proceed to step 9 on page 8.

2) If you use an existing WebSphere Application server, the server setup application .ear file
has been updated. Proceed to step 6 on page 8.

3) If you manually installed Rational Asset Manager to your application server, proceed to
step 5 on page 7. The .ear and .war files that you need to continue the upgrade are now
available in the <installation-directory>\ram\apps directory.

v If you use AIX and you did not use IBM Installation Manager to retrieve the Rational Asset
Manager .ear and .war files, you must install and run Installation Manager to retrieve the latest
application files. To install Installation Manager and update:
a. Retrieve the installation media for the last major release of Rational Asset Manager (version

7.1). If you will not have access to IBM’s update repositories or intend to deploy the update
repository to a local intranet, also retrieve the installation media for the update to version
7.1.1.1.

b. To install IBM Installation Manager, run the launchpad program (launchpad.sh) on disc 1 of
the Rational Asset Manager v7.1 release. For more information, see “Installing from the
launchpad program” on page 25.

c. If you are not using IBM’s update repositories, retrieve the installation media for the update to
version 7.1.1.1, extract all of the compressed files or create a local copy of the disks to the same
directory, and then add the repository location of the extracted repositories to Installation
Manager. For more information, see the Installation Manager online help and “Setting
repository preferences in Installation Manager” on page 93.

d. Installation Manager might need to update itself to a later version. To configure Installation
Manager so that it checks for updates for itself: on the Start page click File → Preferences; then,
click Updates. In the Updates page, select Search for Installation Manager updates.

e. From the Start page of IBM Installation Manager, click Install.
f. Select IBM Rational Asset Manager server and Version 7.1.
g. Click Check for other versions and extensions. Installation Manager will check the

repositories for any later versions and refresh the page with any additional versions that it
finds.

h. Verify that the selected version of Rational Asset Manager changes to Version 7.1.1.1.
i. Continue with the instructions for “Retrieving the Rational Asset Manager server application

for Windows, Linux, or AIX from the installation media with Installation Manager” on page 46.
j. On the Select application server page of the Features window:

– If you are installing to a single WebSphere Application Server node or Apache Tomcat, from
the Select application server list, choose Manual.

– If you are installing to a WebSphere Application Server cluster:
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1) From the Select application server list, choose WebSphere Application Server 6.1.x.
2) Type your server configuration information. For more information, see “Installing

Rational Asset Manager server using Installation Manager” on page 31.
3) On the Context Root page, note the context root for the Setup Server; you will need it to

access the server setup application that will update and deploy the latest applications on
your cluster.

k. Once the install process finishes:
– If you are installing to a single WebSphere Application Server node or Apache Tomcat, the

.ear and .war files that you need to continue the upgrade are now available in the directory
<installation-directory>\ram\apps. Proceed to step 5.

– If you are installing to a WebSphere Application Server cluster, the server setup application
.ear file has been deployed to your cluster. Proceed to step 6 on page 8.

v If you use Linux for zSeries®, manually retrieve the latest version of the Rational Asset Manager
applications. For more information, see “Retrieving the Rational Asset Manager server application
from the installation media for Linux for zSeries” on page 49

5. Deploy the Rational Asset Manager application to your application server:
v If you use WebSphere Application Server and have previously deployed the Rational Asset

Manager server setup application, update com.ibm.ram.repository.setup.web.ear to the latest
version that you retrieved:
a. Launch the WebSphere Administrative Console and log in as an administrator.
b. Update the Rational Asset Manager server setup application:

1) Click Applications.
2) Click Enterprise Applications.
3) Select com.ibm.ram.repository.setup.web.ear, and then click Update.
4) Browse to or type the path and file name of the Rational Asset Manager server setup

enterprise archive file (com.ibm.ram.repository.setup.web.ear).
5) Click Next on the next three pages.
6) On the Summary page, click Finish.
7) When the com.ibm.ram.repository.setup.web.ear file installs, click Save to Master

Configuration. The server setup application is now updated and deployed. Proceed to step
6 on page 8

Note: If you used Rational Asset Manager 7.1.0.1 or earlier, the default context root for the server
setup application has changed from com.ibm.ram.repository.setup.web to ram.setup. If you
bookmarked the server setup application, your bookmark may not work after you update the
server setup application. For more information, see the WebSphere Application Server
documentation on context roots for Web modules.

v If you use WebSphere Application Server and do not have the server setup application
(com.ibm.ram.repository.setup.web.ear) deployed, deploy the
com.ibm.ram.repository.setup.web.ear application by following the instructions “Deploying
Rational Asset Manager on WebSphere Application Server V6.1” on page 55. If you are deploying
to a cluster, see “Manually deploying Rational Asset Manager server setup to a cluster” on page
49. After you deploy the server setup application, proceed to step 6 on page 8.

v If you use Apache Tomcat, manually undeploy the current Rational Asset Manager applications,
then deploy the latest applications:
a. Stop the Tomcat server.
b. Navigate to the directory where you extracted the Rational Asset Manager server update files.

If you used Installation Manager, it should be <install-directory>\apps.
c. Copy the .jar file com.ibm.ram.utility.jar from the directory <install-directory>\apps\tomcat\

shared\lib to the Tomcat server directory <Tomcat-install-directory>\shared\lib.

Rational Asset Manager installation scenarios 7
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d. Restart Tomcat.
e. Undeploy the Rational Asset Manager .war files installed on Tomcat:

1) In a Web browser, open Tomcat Manager (http://<host>:<port>/manager/html) and log on
with the user ID and password for the administrator.

2) Undeploy the following applications:
– /abdprocess
– /com.ibm.ram.repository.web.tomcat_runtime
– /com.ibm.ram.repository.web.ws.tomcat_runtime
– /help

f. Follow the instructions for “Installing Rational Asset Manager server on Tomcat” on page 57.
After you deploy the new applications, proceed to step 9.

6. In a Web browser, open the server setup application by using the URL: http://<host>:<port>/
<setup-server-context-root>. The default URL is: http://<host>:<port>/ram.setup. If security is
enabled on the application server, you will be prompted for the user ID and password for an
application server administrator.

7. Click Update. The server setup application will update all Rational Asset Manager .war and .ear files
to the latest versions and maintain their context roots. When the update process is complete, the
Summary page of the server setup application opens.

8. (Optional) To further configure Rational Asset Manager after you have upgraded, see “Configuring
Rational Asset Manager using the server setup application” on page 34.

Note: After configuration is complete, you must manually remap shared library references for the
previous version of Rational Asset Manager to the RAM1WebApplication (for example, integration
with Rational ClearQuest).

9. Migrate the Rational Asset Manager repository to the newest version:
a. In a Web browser, open the Rational Asset Manager Web client. The first time that you open the

web client after the upgrade, a message is displayed that indicates that you must migrate the
repository.

b. Log on with a user ID that has repository administrator authority. You will see additional
information about the current and required index and database versions.

c. Click Migrate.
d. After the migration process completes, click Home.

10. Update the Rational Asset Manager Eclipse application by using the same method you used to
install it. For more information on installing the Eclipse client, see “Installing the Rational Asset
Manager Eclipse Client” on page 81.

Note: Before you install the latest version of the Rational Asset Manager Eclipse client, uninstall the
Rational Asset Manager Eclipse client plug-in.

If you installed the Rational Asset Manager V7.0.0.2 Eclipse client into an existing Eclipse V3.3
application by using Installation Manager, you must use Installation Manager to uninstall the client.
You cannot use the Eclipse Configuration Manager to uninstall Rational Asset Manager from the
Eclipse client.

If you installed the Rational Asset Manager Eclipse client plug-ins by using Eclipse’s update
manager, before you install the latest version of Rational Asset Manager, use the Eclipse
configuration manager to remove any features that are named Rational Asset Manager. To use the
Eclipse configuration manager, in Eclipse, click Help → Software Updates → Manage Configuration.
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Related tasks

“Retrieving the Rational Asset Manager server application for Windows, Linux, or AIX from the
installation media with Installation Manager” on page 46
“Retrieving the Rational Asset Manager server application from the installation media for Linux for
zSeries” on page 49
“Manually deploying Rational Asset Manager server setup to a cluster” on page 49
“Installing Rational Asset Manager server manually on WebSphere Application Server” on page 50
“Installing Rational Asset Manager server on Tomcat” on page 57
“Configuring Rational Asset Manager using the server setup application” on page 34
“Installing the Rational Asset Manager Eclipse Client” on page 81

Installing Rational Asset Manager using the embedded WebSphere
Application Server V6.1
The following outline guides you through the installation and provides some points to consider before
beginning the installation process.
1. Install a database application for Rational Asset Manager:

Rational Asset Manager requires a database for asset and data storage. If you do not already have one
of the supported database applications installed, then you can install IBM DB2® Enterprise Server
Edition, version 9.5 from the Rational Asset Manager launchpad.
To improve performance, the database server typically resides on a machine that is physically separate
from the application server and on its own dedicated disk.
Users who configures the database tables and schema must have database administrator privileges.
Choose one of the following databases:
a. DB2
b. Oracle
c. SQL Server

2. Install Rational License Server.
Rational Asset Manager server requires the Rational License Server to distribute license keys to clients.

3. Install the embedded WebSphere Application Server V6.1 and the IBM Rational Asset Manager server
application.
Use IBM Installation Manager to install an embedded version of WebSphere Application Server,
Version 6.1 and simultaneously install the Rational Asset Manager server application. This is the
easiest method for installing Rational Asset Manager server.

4. Configure the Rational Asset Manager Server application using the server setup application.
Before you can use Rational Asset Manager server, you must initially configure the Rational Asset
Manager server application. The Rational Asset Manager server setup application is browser-based
application and works like a wizard to set up databases, user authentication, and repository settings.

5. For Linux and AIX: Configure the server environment settings.
Additional configuration steps are required on Linux and AIX.
a. Enable artifact content indexing for Linux.
b. Enable content indexing to run for non-root users.
c. Enable database connectivity for non-root users.

6. Optionally: Install the Rational Asset Manager Eclipse Client.
You can install the Rational Asset Manager Eclipse Client by the following methods:
v If you have a supported Eclipse integrated development environment (IDE) installed on your

computer, then you can use Eclipse update manager to find and install the Rational Asset Manager
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Eclipse client plug-ins from a Rational Asset Manager server. To install the client plug-in, follow the
Eclipse update process (Help → Software Updates → Find and Install).

v If you do not have an existing Eclipse IDE, then you can install the Eclipse client from the Rational
Asset Manager installation media. Note that you can also install the Eclipse client into an existing
Eclipse V3.3.2 IDE by this method.

Installing Rational Asset Manager to an existing WebSphere
Application Server using Installation Manager
The following outline guides you through the installation and provides some points to consider before
beginning the installation process.
1. Install a database application for Rational Asset Manager:

Rational Asset Manager requires a database for asset and data storage. If you do not already have one
of the supported database applications installed, then you can install IBM DB2 Enterprise Server
Edition, version 9.5 from the Rational Asset Manager launchpad.
To improve performance, the database server typically resides on a machine that is physically separate
from the application server and on its own dedicated disk.
Users who configures the database tables and schema must have database administrator privileges.
Choose one of the following databases:
a. DB2
b. Oracle
c. SQL Server

2. Install Rational License Server.
Rational Asset Manager server requires the Rational License Server to distribute license keys to clients.

3. Create a back up of your server configuration using the <wasInstall>/bin/backupConfig.bat
command. Refer to the WebSphere Application Server documentation for more information.

4. If you are installing to WebSphere Application Server V6.1, make sure application security is enabled.
5. Install the IBM Rational Asset Manager server application on the existing WebSphere Application

Server.
Use IBM Installation Manager to install the Rational Asset Manager server application on an existing
WebSphere Application Server. On the Features page of the Installation Manager, choose either
WebSphere Application Server V6.0 or V6.1 depending on your environment.

6. Configure the Rational Asset Manager Server application using the server setup application.
Before you can use Rational Asset Manager server, you must initially configure the Rational Asset
Manager server application. The Rational Asset Manager server setup application is browser-based
and works like a wizard to set up databases, user authentication, and repository settings.

7. For Linux and AIX: Configure the server environment settings.
Additional configuration steps are required on Linux and AIX.
a. Enable artifact content indexing for Linux.
b. Enable content indexing to run for non-root users.
c. Enable database connectivity for non-root users.

8. Optionally: Install the Rational Asset Manager Eclipse Client.
You can install the Rational Asset Manager Eclipse Client by the following methods:
v If you have a supported Eclipse integrated development environment (IDE) installed on your

computer, then you can use Eclipse update manager to find and install the Rational Asset Manager
Eclipse client plug-ins from a Rational Asset Manager server. To install the client plug-in, follow the
Eclipse update process (Help → Software Updates → Find and Install).
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v If you do not have an existing Eclipse IDE, then you can install the Eclipse client from the Rational
Asset Manager installation media. Note that you can also install the Eclipse client into an existing
Eclipse V3.3.2 IDE by this method.

Installing Rational Asset Manager on an existing Apache Tomcat
server
If you do not want to use the Rational Asset Manager with WebSphere Application Server, then you can
install and configure Rational Asset Manager manually on Tomcat. The following outline guides you
through the process of installing Rational Asset Manager on an existing Apache Tomcat server and
provides some points to consider before beginning the installation process
1. Install a database application for Rational Asset Manager:

Choose one of the following databases to install:
a. DB2
b. Oracle
c. SQL Server
Rational Asset Manager requires a database for asset and data storage. If you do not already have one
of the supported database applications installed, then you can install IBM DB2 Enterprise Server
Edition, version 9.5 which is included with the Rational Asset Manager installation media.
To improve performance, the database server typically resides on a machine that is physically separate
from the application server and on its own dedicated disk.

2. Install the Rational Asset Manager server application on an existing Apache Tomcat server.
The following are general steps that you must take to install the Rational Asset Manager server
application on an existing application server:
a. “Installing Rational Asset Manager server using Installation Manager” on page 31: On the Features

pages, choose to install only Rational Asset Manager (to install the server setup application
enterprise archive file) and then choose a manual install, instead of installing to an existing
WebSphere Application Server or installing with embedded WebSphere Application Server. This
will result in the enterprise archives being placed on the file system.

b. Configure security on the application server.
c. Configure the data source for your application server.
d. Deploy the Rational Asset Manager server artifacts.

3. For Linux and AIX: Configure the server environment settings.
Additional configuration steps are required on Linux and AIX.
a. Enable artifact content indexing for Linux and AIX.
b. Enable content indexing to run for non-root users.
c. Enable database connectivity for non-root users.

4. Install Rational License Server.
Rational Asset Manager server requires the Rational License Server to distribute license keys to clients.

5. Configure the Rational Asset Manager Server application.
Before you can use Rational Asset Manager server, you must initially configure the Rational Asset
Manager server application. For example, you must enter the location of the license server.

6. Optionally: refer to the Rational Asset Manager Tuning Guide.
An important administrator responsibility is to ensure the best possible performance for users,
regardless of the number of concurrent users or the number of assets in the repository.

7. Optionally: Install the Rational Asset Manager Eclipse Client.
You can install the Rational Asset Manager Eclipse Client by the following methods:
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v If you have an existing Eclipse integrated development environment (IDE) installed on your
computer, then you can use Eclipse update manager to find and install the Rational Asset Manager
Eclipse client plug-ins from a Rational Asset Manager server.

v If you do not have an existing Eclipse IDE, then you can install the Eclipse client from the Rational
Asset Manager installation media. Note that you can also install the Eclipse client into an existing
Eclipse IDE by this method.
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Installation requirements

This section details hardware and software requirements for successfully installing and running your
software.

Hardware requirements
Before you can install the product, verify that your system meets the minimum hardware requirements.

Server (Windows or Linux)

Hardware Requirements

Processor Minimum: 2 GHz Intel® Pentium® 4, dual CPU (or higher
for best results)

Memory Minimum: 1 GB RAM (with embedded WebSphere
Application Server and DB2 Enterprise Server Edition) or
2 GB (with ClearCase or ClearQuest clients)

Disk space Minimum: 5 GB (with embedded WebSphere Application
Server and DB2 Enterprise Server Edition); if you plan to
add ClearCase or ClearQuest clients, consult their disk
space requirements

Display 1024 x 768 display minimum using 256 Colors (or higher
for best results)

Other hardware Microsoft® mouse or compatible pointing device

Server (AIX)

Hardware Requirements

Processor Minimum: 2 GHz IBM POWER5™ (or higher for best
results)

Memory Minimum (non-production environments): 1 GB RAM
(with embedded WebSphere Application Server and DB2
Enterprise Server Edition)

Minimum (production environments): 2 GB RAM (with
embedded WebSphere Application Server and DB2
Enterprise Server Edition) or 4 GB RAM (with ClearCase
or ClearQuest clients)

Disk space Minimum: 5 GB (with embedded WebSphere Application
Server and DB2 Enterprise Server Edition); if you plan to
add ClearCase or ClearQuest clients, consult their disk
space requirements

Display 1024 x 768 display minimum using 256 Colors (or higher
for best results)

Other hardware Microsoft mouse or compatible pointing device
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Client

Hardware Requirements

Processor Minimum: 1.4 GHz Intel Pentium 4 (or higher for best
results)

Memory Minimum: 512 MB RAM

Disk space Minimum: 500 MB

Display 1024 x 768 display minimum using 256 Colors (or higher
for best results)

Other hardware Microsoft mouse or compatible pointing device

Software requirements
Before installing the product, verify that your system meets the software requirements.

Operating system

The following operating systems are supported for this product:
v Intel 32–bit or 64–bit Microsoft Windows Server 2008 Enterprise Edition (for both client and server)
v Intel 32–bit Microsoft Windows Vista Business Edition with Service Pack 1 (for both client and server;

server is for demo purposes only)
v Intel 32–bit Microsoft Windows XP Professional with Service Pack 2 or 3 (for both Eclipse and Web

clients, and server; server is for demo purposes only)
v Intel 32–bit or 64–bit Microsoft Windows Server 2003 Enterprise Edition with Service Pack 2 (for server

only)
v x86 32–bit Red Hat Linux Enterprise AS4 with update 7 (for both client and server)
v x86 32–bit or 64–bit Red Hat Linux Enterprise 5 with update 2 (for both client and server)
v 64–bit Red Hat Linux Enterprise 5 for zSeries
v Intel 32–bit SUSE Linux Enterprise Server (SLES) Version 10 with Service Pack 2 (for both client and

server)
v 64–bit SUSE Linux Enterprise Server (SLES) for zSeries Version 9 (limited to WebSphere Application

Server Fix Pack 17)
v 64–bit SUSE Linux Enterprise Server (SLES) for zSeries Version 10
v 64–bit IBM AIX 5.3 Power 5 (for server only)
v 64–bit IBM AIX 6.1 (for server only)
v VMware (GSX and ESX); ESX version 3.5 (refer to http://www-01.ibm.com/support/

docview.wss?rs=984&uid=swg21180182)

Application Server (for server)

You can install Rational Asset Manager server that includes an embedded version of WebSphere
Application Server V6.1. Or, you can install Rational Asset Manager server on one of the following
application servers:
v WebSphere Application Server V6.1.0.17
v embedded WebSphere Application Server (eWAS) V6.1.0.17
v PPC32 embedded WebSphere Application Server (eWAS) for AIX V6.1.0.17 or later
v PPC64 embedded WebSphere Application Server (eWAS) for AIX V6.1.0.17 or later
v Apache Tomcat V5.5

For WebSphere, both Network Deployment and clustered deployments are supported.
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Database application (for server)

One of the following database applications is required for the Rational Asset Manager server:
v DB2 Enterprise Server Edition V9.1 or V9.5
v Microsoft SQL Server 2005
v Oracle 10g, 10.2(g), or 11g

You can use any of these supported databases in conjunction with an installation of Rational Asset
Manager server installed on any of the supported application servers.

Web browser

One of the following supported Web browsers is required to run the Rational Asset Manager Web client,
to view the documentation, and to support the Eclipse Standard Widget Toolkit (SWT) browser widget:
v Firefox V2 or V3
v Microsoft Internet Explorer V6.0 SP1 or V7

One of the following Java Runtime Environments (JREs):
v Java Runtime Environment 1.5 (JVM plug-in for Internet Explorer)
v Java Runtime Environment 1.5 (JVM plug-in for Firefox)

Requirements for the Rational Asset Manager Eclipse client

The following software is required for installing the Rational Asset Manager Eclipse client.
v A supported Web browser.
v For Linux: The GNU Image Manipulation Program Toolkit (GTK+), Version 2.2.1 or later and

associated libraries (GLib, Pango).

Requirements for installing the Rational Asset Manager Eclipse client into an
existing Eclipse IDE

The Rational Asset Manager Eclipse client can be installed into, or extend, the following Eclipse IDE’s:
v IBM Rational Software Delivery Platform products (for example, Rational Application Developer,

Rational Software Architect) V7.5
v IBM Rational System Developer or Rational Software Modeler, V7.0.5.1
v IBM Rational Team Concert V1.0
v IBM WebSphere Business Modeler, V6.2
v IBM WebSphere Business Monitor, V6.2
v IBM WebSphere Integration Developer, V6.2
v An Eclipse IDE meeting the following requirements:

– Eclipse V3.3 (via Installation Manager), or V3.4 P2 (via Rational Asset Manager update site)
– Eclipse Modeling Framework (EMF) 2.2 or higher
– Eclipse BIRT plugins 2.1.2 or higher
– A JRE from one of the following Java™ development kits:

- Java Version 5 (or JRE 1.5) service release 6
- Java Version 6 (or JRE 1.6) (using IES 3.4 P2 client)

Additional software requirements
v Adobe® Acrobat Reader
v To view multimedia help, such as tours, tutorials, and demonstrations, you must install Adobe Flash

Player.
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– For Windows: Version 6.0 release 65 or later
– For Linux: Version 6.0 release 69 or later

Other

You can optionally use Rational Asset Manager in conjunction with any of the following software:
v Source control and defect tracking systems:

– Rational ClearQuest V7.0.1 or V7.1
– Rational ClearCase V7.0.1 or V7.1
– Rational Team Concert V1.0
– CVS 1.11.22 or later
– Subversion

v LDAP
– Microsoft Active Directory Server, 2003 server

v WebSphere Service Registry and Repository V6.1 or V6.2.0.2
v Tivoli® Change and Configuration Management Database (CCMDB) V7.1.1

User privileges requirements
You must have a user ID that meets the following requirements before you can install Rational Asset
Manager.
v Your user ID must not contain double-byte characters.
v For Windows: You must have a user ID that belongs to the Administrators group.
v For Linux and AIX: You must be able to log in as root.
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Verifying and extracting electronic images

If you download the installation files from IBM Passport Advantage®, you must extract the electronic
image from the compressed files before you can install Rational Asset Manager.

About this task

If you select the Download Director option for downloading the installation files, the Download Director
applet automatically verifies the completeness of each file that it processes.

Extracting the files
About this task

Extract each compressed file to the same directory. For Linux: Do not include spaces in the directory
names, or you will not be able to run the launchpad.sh command to start the launchpad from a
command line.
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IBM Installation Manager

IBM Installation Manager is a program that helps you install the product packages. It also helps you
update, modify, and uninstall this and other packages that you install. A package can be a product, a
group of components, or a single component that is designed to be installed by Installation Manager.

In most installation scenarios for Rational Asset Manager, you use Installation Manager. Rational Asset
Manager usually requires the most recent version of IBM Installation Manager at the time of release.

For more information about IBM Installation Manager, visit the Installation Manager Information Center
at http://publib.boulder.ibm.com/infocenter/install/v1m0r0/index.jsp.
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Preinstallation tasks

Before you install the product, complete these steps:
1. Confirm that your system meets the requirements that are described in the section “Installation

requirements” on page 13.
2. Confirm that your user ID meets the required access privileges for installing the product. See “User

privileges requirements” on page 16.
3. Read the topic “Planning your installation” on page 3.
4. Read the topic “Rational Asset Manager installation scenarios” on page 5.

Preconfiguring a WebSphere Application Server cluster for Rational
Asset Manager
If you will not be using the Rational Asset Manager server setup application to configure the server, and
you are installing Rational Asset Manager in a WebSphere Application Server cluster, then complete the
steps in this section before installing the Rational Asset Manager enterprise archive files. These steps are
in addition to those required to install WebSphere Application Server in a cluster. If you will be using the
Rational Asset Manager server setup application to configure the server cluster, it is not necessary to
perform the steps in this section.

Before you begin

Before starting, you must determine for each node in the cluster where the persist files and local files will
be.
v Each node in the cluster can share the same persist and local file directories. Rational Asset Manager

can handle sharing the same physical files between multiple servers within the node of a cluster. In
this configuration, the nodes will share the same persist files and the same indexes, thus reducing the
requirements for size and time spent in indexing on the local file system.

v It is not necessary that these paths be exactly the same for all nodes in the cluster. It is possible to
specify unique paths for each node within the WebSphere Administrative Console.

v The persist folder should be a single, shared folder that every node in the cluster can access.

About this task

The following steps are specific to WebSphere Application Server V6.1. The steps for WebSphere
Application Server V6.0 are similar but are not specified.
1. Create the URL resources for the persist and local folders.

a. In the WebSphere Administrative Console, navigate to Resources → URLs.
b. In the Scope field, select a node.
c. Click New.
d. In the Name field, type a name for the URL; for example, Rational Asset Manager Persist.
e. In the JNDI name field, type url/RAM_Persist.
f. In the Specification field, type the URL to the folder that this node will use for the persist folder;

for example, file:///D:/RAMPersist. For better performance, use a network or shared drive that all
nodes in the cluster can access for the persist folder. The format for this URL is:
v For Windows: file:/d:/persistfolder, where the folder is a local folder.
v For Linux and AIX: file:/folder1/folder2/persistfolder, where the folder is a local folder or

a mounted folder.

© Copyright IBM Corp. 2007, 2009 21



v file:////system1.com/persistfolder, where the folder is located on a universal naming
convention (UNC) drive.

g. Click OK.
h. Click New.
i. In the Name field, type a name for the URL; for example, Rational Asset Manager Local.
j. In the JNDI name field, type url/RAM_Local.
k. In the Specification field, type the URL to the folder that this node will use for the local folder.

For better performance, this should not be a shared or remote location. The format for this URL is:
v For Windows: file:/d:/localfolder, where the folder is a local folder.
v For Linux and AIX: file:/folder1/folder2/localfolder, where the folder is a local folder or a

mounted folder.
v file:////system1.com/localfolder, where the folder is located on a universal naming

convention (UNC) drive.
l. Click OK.
m. Click Save.

If you use network share drives for the persist folder and are using Windows, ensure that WebSphere
Application Server has access authority to connect to network share drives. Java processes running as
SYSTEM (the default value) will not connect to network share drives.
a. In the WebSphere Administrative Console, click Servers → Application servers → <server_name> →

Process execution.
b. Under General Properties, in the Run As User field, type the name of an operating system user

that has authority to access the network share drive with the persist folder.
c. Click Save.

Ensure that the WebSphere Application Server process is set to run as the same user.
a. In Windows, click Start → Settings → Control Panel → Administrative Tools → Services (or use the

path that displays the Services.
b. Right-click on WebSphere Application Server and click Properties.
c. On the Log on page, click This account and type the same user ID that you entered for Process

execution.
d. Type the password for the user ID in the Password and Confirm Password text fields.

2. Create the Service Integration Bus.
The Service Integration Bus is the basic communication mechanism and must be created next, before
the Java Messaging Service (JMS).
For security in accessing the bus, determine the user account
a. Define a user that will be used to sign in to the bus. This must be a user that is known to the

cluster: either an administrator ID or, if using LDAP authentication, the ID of a user in LDAP.
1) In the WebSphere Administrative Console, click Security → Secure administration,

applications, and infrastructure.
2) In the Authentication section, click Java Authentication → J2C Authentication.
3) On the next page, click New.
4) On the Create Identity page, enter the following values:

v Alias: Type an alias for the user ID for use by WebSphere Application Server.
v User ID: Type the user ID for the user account that will be used to sign in to the bus.
v Password: Type the password for the user ID.
v Description: Optionally, type a description of the user account.

5) Click OK.
b. Create the Service Integration Bus.
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1) In the WebSphere Administrative Console, click Service integration → Buses.
2) Click New.
3) On the Create a new Service Integration Bus page, type a name for the bus; for example,

RAMBus.
4) Click Next.
5) Click Finish.

c. Configure where the bus resides and where log files are to be stored.
1) On the Display Buses page, select the bus that you created in step 2b on page 22.
2) On the next page, click Bus Members, then click Add.
3) Click Cluster.
4) Select the cluster that you are installing to.
5) Click Next.
6) Click File store.
7) Click Next.
8) On the Provide the message store properties page, enter the following information:

v Log size: Type 10.
v Log directory path: Type ${USER_INSTALL_ROOT}/filestores/com.ibm.we.sib/rambus/log.
v Minimum permanent store size: Type 20.
v Permanent store directory path: Type ${USER_INSTALL_ROOT}/filestores/com.ibm.we.sib/

rambus/log

9) Click Next.
10) Click Finish.

d. Configure the security information to define who can access the bus.
1) On the Display Buses page, select the bus that you created in step 2b on page 22.
2) Click Security.
3) Click Users and groups in the bus connector role.
4) Click New.
5) Click User name.
6) Type the user ID defined for the Service Integration Bus.
7) Click OK.
8) Click Security for <Your_bus_name>.
9) On the Configure the Securities Settings page, enter the following information:

v Enable bus security: Check to enable.
v Inter-engine authentication alias: Select the name of the authentication alias used to

authorize communication between messaging engines on the bus; for example,
<cell_manager>/RAMApp.

v Permitted transports: Click Restrict the use of defined transport channel chains to those
protected by SSL.

10) Click OK.
e. Create a topic on the bus. Rational Asset Manager will use the topic for communications between

the nodes.
v On the RAMBus page, click Destinations.
v Click New.
v Click Topic space.
v Click Next.
v In the Identifier field, type RAM_Topic.
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v Click Next.
v Click Finish.

3. Define the Java Messaging Service information.
Java Messaging Service (JMS) runs on the bus. The bus provides the basic communications between
the servers, and JMS provides the interface to the program.
a. In the WebSphere Administrative Console, click Resources → JMS → Connection factories.
b. In the Connection factories section, click Scope and select the cluster.
c. Click New.
d. Click OK.
e. On the General Properties page, enter the following information:

v Name: Type a name for the factory; for example, Rational Asset Manager Factory.
v JNDI name: Type a JNDI name for the factory; for example, jms/RAM_Factory.
v Bus name: Select the service integration bus that you created in the previous step.
v Target type: Select Bus member name.
v Connection proximity: Select Bus.
v Component-managed authentication alias: Select the alias that you selected in the previous

step; for example, <cell_manager>/RAMApp.
f. In the WebSphere Administrative Console, click Resources → JMS → Topics.
g. In the Topics section, click Scope and select the cluster.
h. Click New.
i. In the General Properties page, enter the following information:

v Name: Type a name for the topic; for example, Rational Asset Manager Cache.
v JNDI name: Type a JNDI name for the topic; for example, jms/RAM_Cache.
v Topic name: Type a name for the topic; for example, Rational Asset Manager Cache. This can be

the same as the name, above.
v Bus name: Select the bus that you created in the previous step; for example, RAMBus.
v Topic space: Select the topic that you created in the previous step; for example, RAM_Topic.

4. Save the configuration changes. You are now ready to install the application enterprise archive for
Rational Asset Manager to the cluster.

Enabling application security on WebSphere Application Server V6.1
If you are installing to an existing WebSphere Application Server V6.1, application security must be
enabled. If application security is not enabled, the Rational Asset Manager server setup application will
be unable to make any configuration changes for WebSphere Application Server.
1. In the WebSphere Administrative Console, click Security.
2. Make sure Enable application security is checked.
3. Click Apply.
4. Click Save.
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Installing from the launchpad program

The launchpad program provides you with a single location to view release information and start the
installation process.

Before you begin

About this task

Use the launchpad program to start the installation of Rational Asset Manager in the following cases:
v Installing from the product CDs
v Installing from an electronic image on your local file system
v Installing from an electronic image on a shared drive

By starting the installation process from the launchpad program, IBM Installation Manager is
automatically installed if it is not already on your computer, and it starts preconfigured with the location
of the repository that contains the Rational Asset Manager package. If you install and start Installation
Manager directly, then you must set repository preferences manually.

Starting the launchpad program
If you are installing from a CD and autorun is enabled on your workstation, then the Rational Asset
Manager launchpad starts automatically when you insert the first installation disc into your CD drive. If
you are installing from an electronic image, or if autorun is not configured on your workstation, then you
must start the launchpad program manually.

Before you begin

Complete the preinstallation tasks described in “Preinstallation tasks” on page 21, if you have not done
so already.

About this task

To start the launchpad program:
1. Insert the IBM Rational Asset Manager CD into your CD drive. For Linux: Ensure that you have

mounted the CD drive.
2. If autorun is enabled on your system, the IBM Rational Asset Manager launchpad program

automatically opens. If autorun is not enabled on your system:
v For Windows: Run launchpad.exe, which is located in the root directory of the CD.
v For Linux and AIX: Run launchpad.sh, which is located in the root directory of the CD.

Starting an installation from the launchpad program
1. Start the launchpad program.
2. If you have not done so already, read the release information by clicking Release notes.
3. When you are ready to begin the installation, click Install IBM Rational Asset Manager.
4. If IBM Installation Manager is not detected on your system or if an older version is already installed,

then you must continue with the installation of the latest release.
a. Follow the instructions in the wizard to complete the installation of IBM Installation Manager.

Refer to “Installing Installation Manager on Windows” on page 91 for more information.
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b. When the installation of IBM Installation Manager completes successfully, click Finish to close the
wizard. After the installation is complete, IBM Installation Manager opens automatically.

5. If this is a new installation, click Install Packages and follow the instructions in the wizard to
complete the installation process. For complete details, see “Installing Rational Asset Manager server
using Installation Manager” on page 31

6. If this is a product update, click Update Packages and follow the instructions in the wizard to
complete the update process. For complete details, see “Upgrading from a previous version of
Rational Asset Manager” on page 5.
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Installing IBM DB2 Enterprise Server Edition, version 9.5

If you do not already have one of the supported database applications installed, then you can install IBM
DB2 Enterprise Server Edition, version 9.5 which is included with the Rational Asset Manager installation
media.

About this task

Installation instructions and release notes, as well as information about working with DB2 are available in
the IBM DB2 Database for Linux, UNIX®, and Windows Information Center. See http://
publib.boulder.ibm.com/infocenter/db2luw/v9r5/index.jsp.
v For installation instructions, click Database fundamentals → Installing → Database systems. For

Windows, click DB2 Database for Windows and click the appropriate installation topics. For Linux,
click DB2 Database for Linux and UNIX → DB2 Servers and click the appropriate installation topics.

v For release notes, click Product overviews → DB2 Database for Linux, UNIX, and Windows → Release
notes.

To start an installation of DB2 Enterprise Server Edition, version 9.5:
1. Start the DB2 Setup Launchpad program. From the Rational Asset Manager launchpad program, click

Install IBM DB2 Enterprise Server Edition, Version 9.5. If you are installing from CD media, you
might be prompted to insert the first DB2 installation CD. The DB2 Setup Launchpad starts.

2. Make sure that you have read the release information that is available in the DB2 Setup Launchpad or
in the information center.

3. In the left menu, click Install a product, and then in the page that opens, under DB2 Enterprise
Server Edition, click Install new. The DB2 Setup wizard opens.

4. Follow the instructions in the wizard to complete the installation. For more information, see the
installation instructions in the IBM DB2 Database for Linux, UNIX, and Windows Information Center or
click Help in the DB2 Setup wizard.

Registering the DB2 license key
The DB2 Enterprise Server Edition, Version 9.5 license key must be registered using the db2licm
command.

About this task

The DB2 product uses the license key information contained in the nodelock file. The nodelock file is
created or updated by running the db2licm command and specifying the license file for the DB2 product.
Creating or updating the nodelock file is referred to as registering the DB2 product license key.

The DB2 product uses the license key information that is contained in the nodelock file, which is created
or updated by running the db2licm command and specifying the license file for the DB2 product. To
register the license key, you must run the db2licm command on each computer where DB2 is installed.

To manually register your DB2 product license key using root authority:
1. Log in as a user with root authority.
2. Register the DB2 product license key with the appropriate command:

v /usr/opt/db2_08_01/adm/db2licm -a filename on AIX
v /opt/IBM/db2/V8.1/adm/db2licm -a filename for all other UNIX-based operating systems
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where filename is the full pathname and filename for the license file that corresponds to the product
you are bundling.

For example, on AIX, if the CD-ROM is mounted in the /cdrom directory and the name of the license file
is db2ese_o.lic, the command should be: /usr/opt/db2_08_01/adm/db2licm -a /cdrom/db2/license/
db2ese_o.lic

After running the db2licm command, the DB2 product license key information is contained in the
nodelock file in the following directories:
v AIX: /var/ifor.
v HP-UX, Linux, or Solaris Operating Environment: /var/lum.
v Windows: DB2PATH/sqllib/license.

To register your DB2 product license key as the instance owner:
1. Create the instance environment and become the instance owner.
2. Register your DB2 product license with the appropriate command:

v For UNIX operating systems: db2instance_path/adm/db2licm -a filename

v For Windows operating systems: db2instance_path\adm\db2licm -a filename

where db2instance_path is where the DB2 instance was created and filename is the full pathname and
filename for the license file that corresponds to the product that you are bundling.
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Installing Rational License Server

Rational Asset Manager server requires the Rational License Server to distribute license keys to clients.

About this task

Perform™ the following steps to install and configure Rational License Server for IBM Rational Asset
Manager:
1. Install IBM Rational License Server.

If you are using Rational License Server 7.0 or prior on any platform, you will need to upgrade to the
Rational License Server for Windows 7.0.1 or the Rational License Server for UNIX and Linux 7.0.0.1.
Rational License Server 7.0.1 and 7.0.0.1 are fully compatible with your previously installed license
keys and will continue to service your existing client machines.
IBM Rational License Server is included with the Rational Asset Manager installation media.
v For Windows: Use Rational License Server for Windows 7.0.1.
v For Linux: Use Rational License Server for UNIX and Linux 7.0.0.1.

2. Request and install your license keys.
The number of license keys that are available determines the number of users that can be
simultaneously logged in to the Web application.
For more information on Rational licensing and to get your Rational Asset Manager license keys, see
the Rational licensing support page at http://www.ibm.com/software/rational/support/licensing/.

3. Start the Rational License Server. See the IBM Rational License Management Guide or the License Key
Administrator Help.

4. Configure Rational Asset Manager server to communicate with Rational License Server.
You can configure Rational Asset Manager server to communicate with Rational License Server by
either using the Rational Asset Manager server setup application, or manually. For instructions on
installing Rational Asset Manager and using the server setup application, see the section “Installing
and configuring Rational Asset Manager using Installation Manager and the server setup application”
on page 31. For instructions on manually configuring Rational Asset Manager server to communicate
with the license server, see the topic “Configuring the Rational Asset Manager server application” on
page 62.
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Installing and configuring Rational Asset Manager using
Installation Manager and the server setup application

This section describes how to install and configure the Rational Asset Manager server using Installation
Manager and the server setup application.

About this task

There are three primary ways to install and configure the Rational Asset Manager server using
Installation Manager:
1. Install Rational Asset Manager server that includes an embedded WebSphere Application Server, V6.1.
2. Install Rational Asset Manager server code on an existing WebSphere Application Server or cluster of

servers.
3. Install Rational Asset Manager enterprise and Web archives to the file system, so that they can be

manually deployed to an application server.

Installing Rational Asset Manager server using Installation Manager
You can install the Rational Asset Manager server application (which also installs the server setup
application), the help and documentation Web archive, or the asset-based development process Web
archive using the Installation Manager. You can choose to install the server application with an embedded
version of WebSphere Application Server, Version 6.1, on an existing version of WebSphere Application
Server, Version 6.1 or 6.0, or to the file system for later deployment on a supported application server.
You can install to a single node or to a cluster.

Before you begin

Before you begin this installation, make sure that the database application (DB2, Oracle, or SQL Server) is
installed and running.

If you are installing to a WebSphere Network Deploy Server, make sure you have at least one cluster
defined.

If you are installing to a cluster and will not be using the Rational Asset Manager server setup
application to configure the servers, make sure that you have completed the steps in the section entitled
“Preconfiguring a WebSphere Application Server cluster for Rational Asset Manager” on page 21.

About this task

If you start the installation from the launchpad, you will be prompted to install Installation Manager if it
is not already on your system. Then the Install Packages wizard starts automatically.
1. Start the Rational Asset Manager launchpad program (see “Installing from the launchpad program”

on page 25). To use a different language, select it from the Language selection list.
2. Select Install IBM Rational Asset Manager server V7.1. The Install Packages wizard opens.
3. On the Install page, select IBM Rational Asset Manager server Version 7.1. If the latest version of

Installation Manager is not installed, it will also be listed; select it. If installing from the launchpad,
proceed to step 7 on page 32.

4. To search for updates to the IBM Rational Asset Manager server package, click Check for Other
Versions and Extensions.
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Note: For Installation Manager to search the predefined IBM update repository locations for the
installed packages, the preference Search service repositories during installation and updates on
the Repositories preference page must be selected. This preference is selected by default. Internet
access is also required.
Installation Manager searches for updates at the predefined service repository for the product
package. It also searches any repository locations that you have set. A progress indicator shows that
the search is taking place. You can install updates at the same time that you install the base product
package.

5. If updates are found for the IBM Rational Asset Manager server package, then they are displayed in
the Installation Packages list on the Install Packages page following their corresponding product.
Only the latest updates are displayed by default.

6. Select Rational Asset Manager server and any updates to the package that you want to install.
Updates that have dependencies are automatically selected and cleared together.

Note: If you install multiple packages at the same time, then all of the packages will be installed
into the same package group.
Note that the Rational Asset Manager client is not required for installing the server application.

7. Click Next to continue.
8. On the Licenses page, read the license agreement for the selected package. If you selected more than

one package to install, there might be a license agreement for each package. You can select each
package version to display its license agreement to the left. The package versions that you selected
to install (for example, the base package and an update) are listed under the package name.
a. If you agree to the terms of each license agreement, click I accept the terms of the license

agreements.
b. Click Next to continue.

9. On the Location page, type the path for the shared resources directory in the Shared Resources
Directory field; or accept the default path. The shared resources directory contains resources that can
be shared by one or more package groups. Click Next to continue.
The default path is:
v For Windows: C:\Program Files\IBM\IBMIMShared
v For Linux and AIX: /opt/IBM/IBMIMShared

Important: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this directory to help ensure that adequate space is available for
the shared resources of future packages. You cannot change the directory location unless you
uninstall all packages.

10. On the Location page, either choose an existing package group to install the IBM Rational Asset
Manager server package into, or create a new one. A package group represents a directory in which
packages share resources with other packages in the same group. To create a new package group:
a. Click Create a new package group.
b. Type the path for the installation directory for the package group. The name for the package

group is created automatically.
The default path is:
v For Windows: C:\Program Files\IBM\RAM71Server
v For Linux and AIX: /opt/IBM/RAM71Server

c. Click Next to continue.
11. On the Features page under Languages, select the languages for the package group. The

corresponding national language translations for the user interface and documentation for the IBM
Rational Asset Manager server package will be installed. Note that your choices apply to all
packages installed under this package group.
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12. On the next Features page, select IBM Rational Asset Manager server, and choose from three
options:
v Rational Asset Manager. This installs the server enterprise archive file, including the Web client,

and the server setup enterprise archive file. You must select this option if you want to use the
server setup to deploy the Rational Asset Manager server and Web applications.

Note: When installing into a cluster, the Rational Asset Manager server application is the only
application installed on the server. The other files will be deployed via the server setup
application.

v Asset-based Development and Governance Process: This installs a Web archive with
documentation about asset-based development process.

v Rational Asset Manager Help and Documentation Web Archive: This installs a Web archive with
user assistance for the Rational Asset Manager Web client.

If you choose not to install any of these options and proceed with the installation process, the
Rational Asset Manager installation root folders will be created, which contain configuration files,
database scripts, a documentation folder with the readme and installation guide files, and embedded
WebSphere Application Server (if you select it in the next step).

13. On the next Features page, select the application server:
v Packaged embedded WebSphere Application Server: Installs a new embedded WebSphere

Application Server and the features you selected in step 12. If you choose this option, proceed to
step 14.

v WebSphere Application Server V6.0.x. Installs the features you selected in step 12 into an existing
installation of WebSphere Application Server V6.0.x that you specify. If you choose this option,
proceed to step 15.

v WebSphere Application Server V6.1.x. Installs the features you selected in step 12 into an existing
installation of WebSphere Application Server V6.1.x that you specify. If you choose this option,
proceed to step 15.

v Manual. Places the features you selected in step 12. Choose this option if you want to deploy the
enterprise and Web archives using the server setup application. If you choose this option, click
Next and proceed to step 16 on page 34.

14. If you selected Packaged embedded WebSphere Application Server, indicate the server configuration:
a. To create a service for the application server, click Yes.
b. Specify the embedded WebSphere Application Server ports, or leave the default port

assignments. The Available column indicates whether the port is already in use or not.

Table 1. Port definitions for embedded WebSphere Application Server V6.1

Port name Default value

HTTP Transport Port (WC_defaulthost) 13080

Administrative Console Port (WC_adminhost) 13060

HTTPS Transport Port (WC_defaulthost_secure) 13443

Administrative Console Secure Port
(WC_adminhost_secure)

13043

Bootstrap Port (BOOTSTRAP_ADDRESS) 13809

SOAP Connector Port (SOAP_CONNECTOR_ADDRESS) 13880

c. Proceed to step 17 on page 34
15. If you selected WebSphere Application Server V6.0.x or V6.1.x, indicate the server configuration:

a. In the Application server location text field, type the full path to the application server on the
local machine, or click Browse and navigate to it. For example, on a full installation of
WebSphere Application, enterC:\Program Files\IBM\WebSphere\AppServer\profiles\
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<profile_name> (where profile name is the name of the profile on the server). On an installation
of embedded WebSphere Application Server installed with Rational Asset Manager, by default
this is C:\Program Files\IBM\RAM71Server\ram\ewas\profiles\profile1.

b. In the Server root URL text field, type the root URL for the server. By default, this URL is
http://localhost:9080. If you use a different port number for your WebSphere Application
Server administrative console for the profile you selected in the previous step (for example, if
security is enabled, or if there are multiple profiles on the application server), enter that port
number here in place of 9080.

c. If you have security enabled on your application server, type an administrator’s user name and
password. If security is not enabled, clear the checkbox.

d. In the Type of server configuration section, indicate whether you are installing a single node or a
cluster and provide the server or cluster name. The server must be identified in the Server
Configuration section and must be running.

e. Click the Get list from server button.
v For single node installations, the name of the server will be displayed in the text field (for

example, ″server1″).
v For cluster installations, a list of cluster names will be displayed. Select the name of the cluster

to install to from the list.
f. Click Next.

16. On the Summary page, review your choices. If you want to change the choices or configuration
details that you made on previous pages, click Back, and make your changes.

17. When you are satisfied with your installation choices, click Install. A progress indicator shows the
percentage of the installation completed.

18. When the installation process is complete, a message confirms the success of the process.
a. Click View log file to open the installation log file for the current session in a new window. You

must close the Installation Log window to continue.
b. Click Finish. The Install Package wizard closes.

Unless you chose a manual installation in step 13 on page 33, the Rational Asset Manager
Configuration Web page opens in a browser window. Follow the instructions to restart the server (or
restart the server, if it was already running) and then click the link to start the Rational Asset
Manager server setup application. The server setup application is a wizard for configuring the
database, the database connection, security, and repository settings. For instructions on using the
server setup application, refer to the section entitled “Configuring Rational Asset Manager using the
server setup application.”
If you chose a manual installation, manually deploy the server setup application to the application
server. To manually deploy the server setup application to a cluster, see the topic “Manually
deploying Rational Asset Manager server setup to a cluster” on page 49.

Configuring Rational Asset Manager using the server setup application
The server setup application is a browser-based Web application that opens after the Installation Manager
has finished installing Rational Asset Manager features on a new embedded WebSphere Application
Server or an existing WebSphere Application Server. It functions like a wizard to help you configure
database, security, and repository settings. You can use the server setup application to later modify these
settings instead of using the Administration pages within Rational Asset Manager Web client. You can
also use the server setup application to deploy any of the Rational Asset Manager features on an
application server.

Before you begin

To use the server setup application, the following prerequisites must be met:
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v The com.ibm.ram.repository.setup.web enterprise archive must be deployed on a running application
server. This could have been done by using the Installation Manager to install the Rational Asset
Manager feature:
– With embedded WebSphere Application Server
– On an existing WebSphere Application Server
– Manually, and then manually deploying the enterprise archive on an existing application server.

Refer to “Installing Rational Asset Manager server using Installation Manager” on page 31 for more
information on these options in Installation Manager.

v A database application must be installed, either locally or remotely, that the Rational Asset Manager
server can access. You must have administrative access to the database server. If you plan to use the
server setup application to configure DB2, the browser that you run the server setup application in
must be located on the machine where DB2 is installed.

About this task

The setup enterprise archive must be deployed and running, and the database server must be running. If
the setup enterprise application is not already open, open it in a browser using the URL:
http://<host>:<port>/ram.setup. If security is enabled on the application server, you will be prompted
for the user ID and password for an application server administrator.

As you configure Rational Asset Manager, the server setup application creates and updates a log file that
records all changes to your server environment. To view all of the current changes you have made while

using the server setup application, click Tools → View/hide log ( ). A list of your current changes will
appear at the bottom of your browser view. As you configure Rational Asset Manager, the log will
automatically update. While the log is in view, to view a complete record of all the changes that the

server setup application has ever made to your server environment, click View full log ( ).

To view the current details of your server environment, click Tools → View configuration report ( ).
1. On the Introduction page, indicate the type of database and user authentication to be used.

a. Select the database application from the list: IBM DB2, Oracle, or SQL Server.
b. Select the type of user authentication that the Rational Asset Manager Web application will use:

v LDAP: user information is stored in a Lightweight Directory Access Protocol repository. You
will need administrative information for accessing the repository.

v File: user information is stored in a custom user registry, as defined for your application
server; this might appear in the list as the name of the custom registry as defined for the
application server. An example custom user registry is File, where user information is stored in
a flat file on the server. Select this option if you are not using any of the other types of
authentication.

Note: File-based authentication is not intended for use in a production environment.
v Federated Repository: user information is stored in multiple repositories, such as LDAP

repositories. This type of authentication is managed by WebSphere Application Server.
v Local Operating System: user information is stored in the user accounts database on the local

operating system. This type of authentication is managed by WebSphere Application Server.
c. Confirm that the server or cluster listed is the one that you want to configure.
d. Click Next.

2. In Section 1, Part 1, either create a new database or connect to an existing database.
a. Select whether to create a new database or use an existing database.

v To create and populate a new database, click Create a Database. Proceed to step 2b on page
36.
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v To use an existing database (for example, if you are upgrading from a previous version of
Rational Asset Manager), click Use Existing Database. Proceed to step 3

b. Create a database.
v For DB2, you can use a Java applet to create and populate the database, or you can perform

these manually.
– To use the Java applet:

1) After the applet loads, it looks for an instance of DB2 on the local machine. Note that
the browser that you run the server setup application on must me located on the
computer where DB2 is installed. If it finds one, the location of the DB2 installation and
its version are displayed. If it does not find one, you are prompted to enter the location.

2) To use a different installation of DB2, click Change DB2 location.
3) Once you have selected the appropriate location, type a name for the database in the

Database name field (for example, RAMDB) and click Create Database.
– To manually create and configure the DB2 database, click Manually configuring and

creating tables in DB2 and follow the displayed instructions.
v For Oracle or SQL Server, follow the instructions to manually create and populate the database.

The instructions displayed in the server setup application are identical to those in “Creating and
configuring a database for Rational Asset Manager” on page 43.

3. In Section 1, Part 2, specify the database connection properties.
a. Type the name of the database in the Database name field; for example, RAMDB.
b. Type the host name or IP address of the database server in the Database server text field; for

example, servername.example.com. (Do not use localhost).
c. Type the port number in the Port field. For example, the default value for DB2 is 50000.
d. Type the user ID and password of a user with administration authority for the database

application.
e. Select to either provide the location of the archive file or files required by the database on the

server, or upload them to the server.
v To enter the location of the archive files on the server, type the full path to the folder that

contains them; for example, C:\Program Files\IBM\SQLLIB\java.
v To upload the files to the server, select that option and browse to the file or files on the local

machine. By default, these are available in <RAM V7.1 install root>\ram\ewas\
universalDriver\lib on the local machine. When uploaded to the server, they will be placed
in <WAS_install_directory>\profiles\<profile_name>\config\cells\<cell_name>\ram_jdbc

Note: For Linux or AIX: Replace backslashes (″\″) in the directory paths with forward slashes
(″/″).

Important: For Linux or AIX: If you must run WebSphere Application Server or Apache
Tomcat as a non-root user, then you must set the appropriate permission on the database Java
archive files that you upload. Refer to the instructions in “Enabling database connectivity for
non-root users (Linux and AIX)” on page 65.

f. Click Test Connection. The server setup application will report whether the server could connect
to the database.

g. If the connection test was successful, click Next. If the database was configured correctly, the
Database Performance Settings page opens.

4. In Section 1, Part 3, If you use DB2, you can configure database settings to optimize the performance
of Rational Asset Manager. If you are using Oracle or SQL, you will not be able to configure
database settings here.
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a. If you are using DB2, configure your database settings. Suggested values and current values for
the following parameters are listed. Select Use recommended values to change all parameters to
the recommended values. Changes made to database settings take effect when you restart the
database server.
v LOCKLIST: Type a number between 4 and 60000, inclusive, to specify the amount of storage

that is allocated to the lock list.
v LOCKTIMEOUT: Type a number between 1 and 30000 to specify the number of seconds that

an application waits to obtain a lock. Setting this property helps avoid global deadlocks for
applications. A value of -1 means lock timeout detection is turned off.

v LOGFILSIZ: Type a number to specify the size of each primary and secondary log file. The
size of these log files limits the number of log records that can be written to them before they
become full and a new log file is required. The value of the logfilsiz should be increased if the
database has a large number of update, delete, or insert transactions running against it which
will cause the log file to become full quickly.

Note: Changing the LOGFILSIZ parameter from the default is only necessary when there are
a large number of assets in the repository (for example, tens or hundreds of thousands).

v MAXAPPLS: Type a number greater than the number of expected concurrent connections.
v MAXLOCKS: Type a number between 1 and 100 to specify the percentage of the lock list that

is reached when the database manager performs escalation, from row to table, for the locks
held by the application. Although the escalation process does not take much time, locking
entire tables versus individual rows decreases concurrency, and potentially decreases overall
database performance for subsequent attempts to access the affected tables.

b. Click Next.
5. In Section 1, Summary, the server setup application will prompt you to restart the server. If you will

be continuing through other sections of the server setup application, you can wait to restart the
server until you have finished those sections.
v If you are done with your configuration settings (for example, if you are using the server setup

application to make changes to an existing setup), restart the server now. To restart the server,
click Tools → Restart the server.

v To continue without restarting the server now, click Next.
6. In Section 2, configure users and authentication.

v If you chose LDAP authentication in step 1b on page 35, configure the connection to the LDAP on
the Configure LDAP Authentication page. LDAP must be running and the LDAP server must be
accessible from this machine.
a. Configure the LDAP repository connection. On this page, you define the information that

Rational Asset Manager server will use to contact the LDAP server: the address of the LDAP
server, the communications port, and if necessary, a user ID and password Rational Asset
Manager will sign in as in order to query the registry.
– LDAP Vendor: Select your LDAP software.
– Server: Type the name of the machine where LDAP is installed; for example,

ldap.example.com. If security is enabled on the LDAP server, check SSL enabled.
– Port: Type the port number of the LDAP server.
– Connect Anonymously: Check this box if your LDAP repository does not require a user ID

and password for access. If it does require a user ID and password, clear this box and
complete the Bind User DN and Bind Password text fields.

– Bind User DN: Type the distinguished name (DN) of a user that has access to query the
LDAP database. Rational Asset Manager will use this user name to access LDAP. For
example, uid=123456,c=us,ou=exampleorganization,o=example.com.

– Bind password: If you typed a user DN, type the password for the user name.
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b. Click Test connection. If the server setup application was able to connect to LDAP, continue.
You cannot proceed with LDAP Authentication until a connection has been properly
configured.

c. Identify a user in the LDAP registry who will be a Rational Asset Manager repository
administrator.
– Administrator ID: Type the unique ID of the user who will be the repository administrator

for Rational Asset Manager. The repository administrator is responsible for configuring
Rational Asset Manager server. For example (if your LDAP uses e-mail address as the
unique identifier) Administrator@example.com.

– Password: Type the password for the administrator ID.
– User search filter: Type the syntax that LDAP will use to query for a user. The %v

represents the search term that was entered from an input text field. The search will perform
as if a wild card is appended to the search term. The default search template is constructed
to find all person objectClasses where either the mail property or the name property is the
same as the search term.

– User search base: Type the path of the root from where to start searching the LDAP registry
for users; for example, ou=exampleorganization,o=example.com.

d. Click Verify the User.
e. If the server setup application was able to find the user in the LDAP registry, click Next. Do

not continue configuring LDAP authentication until a user has been identified as the repository
administrator.

f. On the next page, map user properties in Rational Asset Manager to the corresponding user
properties in your LDAP registry. Rational Asset Manager requires this information for user
authentication, for user data retrieval and display, and to communicate with users by e-mail.
– Unique identifier: Type the property name of the user’s objectClass instance that represents

the unique user’s ID. For example: (objectClass) person’s serialNumber property, or the
(objectClass) user’s sAMAccountName property. The default value is uid.

– Login identifier: Type the (objectClass) property that users use as their login ID. Even
though it is common for the Unique ID and login ID to be the same, it is possible that the
registry may be set so that a user logs in using another ID (for example, an e-mail address).
For example, userPrincipleName.

– LDAP user name query: Type the LDAP search query that maps the short name of a user to
an LDAP entry; for example, *:userPrincipleName or *:uid.

– E-mail: Type the name of the property that contains a user’s e-mail address; for example,
mail.

– Phone number: Type the name of the property that contains a user’s phone number; for
example, telephonenumber.

– Image URL Template: It is common to store images somewhere other than an LDAP
registry. If it is possible to retrieve a user’s image using a URL, configure this template to
retrieve the image at the same time as the user information in the registry. In the template,
${value} represents a LDAP user property of the user object that is going to be replaced
when the image is retrieved. For example, for a user with a uid property=123456, the default
template https://<image_server_url>/photo/${uid}.jpg results in the URL
https://<image_server_url>/photo/123456.jpg.

g. Click Test the Mapping. If all mappings are correct, the administrator’s user ID, name, e-mail,
phone number, and photo are displayed, with a success message.

h. Specify user group properties in LDAP. User group information in LDAP can be retrieved and
reused by Rational Asset Manager communities. In Rational Asset Manager, communities are
the primary organizational grouping within a repository: they are collections of users with a
common interest in a set of assets, and each community can define its members, member roles,
permissions, processes, and assets.

38 IBM Rational Asset Manager, version 7.1.1.1 : Installation guide



– User group search filter: filter for searching groups. The default searches any of
groupOfUniqueNames (static group), groupOfNames (static LDAP group), groupOfUrls
(dynamic LDAP group), group (Active Directory defined group) for the search term entered
by the user.

– User group search base: Type the base search for searching groups; for example,
ou=memberlist,ou=groups,o=example.com.

– Group ID Map: Type the LDAP search query that maps the short name of a group to an
LDAP entry; for example, *:cn.

– Group Member ID Map: Type the LDAP search query that identifies user-to-group
relationships; for example, memberof:member.

i. Click Next. The Users and Authentication Configuration summary page opens.
j. You can restart the application server to complete the configuration, or restart the server after

you have completed the other steps in the server setup application.
k. Click Next.

v If you chose File-based authentication in step 1b on page 35, add or delete users from the list on
the Configure File-based Authentication page. File-based authentication means that user
information is stored in a text file on the server. By default there are six users (″admin″ and
″user1″ through ″user5″).

Note: The passwords for the six default users are the same as their user IDs.
a. Add, edit, or delete users.

– To filter the list of users, type a search string in the Search text field and click Search. Wild
cards (*) can be used. To see the entire list, type * in the Search text field.

– To add a user, click Add User and type the user’s ID and password.
– To delete a user, click Delete next to that user’s name.

b. When finished, click Next. The Users and Authentication Configuration summary page opens.
c. You can restart the application server to complete the configuration, or restart the server after

you have completed the other steps in the server setup application.
d. Click Next.
e. Proceed to step 7.

v If you chose to use a federated repository, the local operating system, or a custom user registry
(other than file-based) in step 1b on page 35, you will be prompted to confirm that the user ID of
the administrator for the user registry will be the repository administrator. There are no
configuration options for these types of authentication.

7. In Section 3, Applications that are successfully deployed are indicated, with the cluster or server
name that they are deployed on listed. To deploy any Rational Asset Manager enterprise archives
that were not deployed by Installation Manager:
a. Select any application that you wish to deploy.
b. From the Clusters and servers list, select the clusters or servers to deploy to.
c. Click Deploy Applications. The progress of the deployments is displayed on a separate page,

and the result of the process is displayed on the Deploy Rational Asset Manager page.
d. Click Next.
e. On the Summary page, click Next.

8. In Section 4, configure settings for Rational Asset Manager.
a. Type the address for the license server in the format <port>@<host_name>; for example,

27000@example.com. By default, Rational License Server uses TCP/IP port 27000.
b. Configure the address of the server with the applications that were deployed in step 7. Type the

protocol, fully qualified host name, and port number; for example, http://example.com:9080.

Important: Always use a host name or IP address for these entries. Do not use localhost.
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c. Configure the paths for the applications. The default paths are based on the server address
provided.
v Rational Asset Manager: Type the deployment URL for the Rational Asset Manager server

application; for example, http://example.com:9080/com.ibm.ram.repository.web.
v Web Services: Type the deployment URL for the Web services; for example,

http://example.com:9080/com.ibm.ram.repository.web.ws.was

v Help and User Assistance: Type the deployment URL for the Rational Asset Manager user
assistance application; for example, http://example.com:9080/help.

v Asset-Based Development Process: Type the deployment URL for the Rational Asset-based
Development Process application; for example, http://example.com:9080/
com.ibm.ram.repository.web/abdprocess.

To modify the locations or context roots (for example, if you have specified different context roots
in WebSphere Application Server), click Edit.

d. Click Next.
e. Configure the persist and local storage folder locations. If you are installing to a cluster, the

cluster name is displayed and you must do this for every node in the cluster.
v Persist folder: Type the full path to the folder where assets and search indexes are to be stored

on the file system. This can be a mapped directory. If installing to a cluster, this must be a
location that is shared between all of the nodes of the cluster.

v Local storage folder: Type the full path to the folder where data are to be stored by the
Rational Asset Manager Web application. This must be a location on the local machine, and not
a mapped or shared location. If installing to a cluster, each node in the cluster must have its
own local storage folder that is not shared with the other nodes. If installing multiple servers
on the same physical node, the servers should all use the same physical local storage folder.

Tip: For best performance, the drive should be capable of fast reads and writes, and should
not be the same drive as the operating system or application server. For cluster installations,
each machine should have its own local folder on a hard disk local to the machine. Using a
local folder that is shared between all application servers will degrade performance.

For cluster installation, to use the settings that you entered for the first node for all nodes, click
Use these settings for all nodes.

f. Click Next.
g. For cluster installations, Java Messaging Service (JMS) must be correctly configured for Rational

Asset Manager to communicate between servers in the cluster. Confirm that JMS is configured
correctly and click Next.

9. Optionally, you can configure performance settings for WebSphere Application Server.
a. Configure server settings.

v Class garbage collection: Optionally, type the name of the garbage collection algorithm to use.
The recommended value is intended to result in increased server performance:
– For Windows: -XX:+UseParallelGC
– For Linux or AIX: -Xgcpolicy:optavgpause

v Performance monitoring: For best performance, performance monitoring should remain
disabled. To turn on performance monitoring on the application server, check Enable.

v Maximum number of sessions: Type the number of sessions that WebSphere Application
Server will maintain in memory. The default value is 1000. Increase this number to allow more
sessions to be maintained in memory.

v JDBC maximum connections: Type a number equal to or greater than the number of users
that might be logged in to Rational Asset Manager at one time. For example, 100.

v Session timeout (minutes): Type a number for the number of minutes before a user’s session
times out. The default number of minutes in WebSphere Application Server is 30.
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Tip: While reducing the Session timeout value might allow for more users, especially if many
users will be making brief transactions, setting it too low might interfere with a user’s
experience or prevent users from uploading large assets.

v Web container minimum size: Type the minimum number of threads to allow in the Web
container. The default value is 25 for Windows and 15 for Linux and AIX. Increase this number
if the CPU for the server is underutilized, or decrease it if the CPU is overutilized.

v Web container maximum size: Type the maximum number of threads to allow in the Web
container. The default value is 50for Windows and 30 for Linux and AIX. Increase this number
if the CPU for the server is underutilized, or decrease it if the CPU is overutilized.

b. Click Next.
c. On the Configure Java Virtual Memory Heap Settings page, you can change the heap size for the

server. If installing to a cluster, you can set the heap size per node. The default is ″No setting.″
Before selecting one of the other options (Low, Medium or High), ensure you know how much
physical memory is available on the machine.

d. Click Next. The summary page is displayed again. You can choose from the options in step 11.
10. In Section 5, confirm that the settings are correct and restart the server.

v Click the section headings to view settings. If settings are not correct, or to make changes, click
Previous or the name of the section at the top of the page to return to that section.

v Click Restart the Server at the bottom of the page to restart WebSphere Application Server. You
cannot launch any of the Rational Asset Manager deployed applications until the server has been
restarted. After the server has restarted, proceed to step 11.

11. Rational Asset Manager is now running. You can do any of the following:
v Tour the Web Client. Select this option to view a multimedia tour of the Web client. The Help and

User Assistance Web archive must be installed to view the tour.
v Start Rational Asset Manager. Select this option to launch the Rational Asset Manager Web client

and continue configuring the repository, set up user communities, or begin working with assets.
v Performance and Tuning Settings. Select this option to configure settings that might improve

server performance. The options here are identical to step 9 on page 40
v Exit the server setup application.

What to do next

For additional performance tuning information, refer to the “Rational Asset Manager Tuning Guide” on
page 67.
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Manually installing and configuring Rational Asset Manager
on an existing application server

Follow these procedures to manually install and configure Rational Asset Manager if you want to use
your existing WebSphere Application Server or cluster environment.

About this task

The following list is the order of the steps that you must take to install Rational Asset Manager for use
with an existing application server:
1. Create the database tables in an existing database (DB2, Oracle or SQL Server 2005).
2. Retrieve the Rational Asset Manager server artifacts from the installation media using IBM Installation

Manager.
3. Configure a datasource for your application server (WebSphere Application Server or Tomcat).
4. Configure security on the application server.
5. Deploy the Rational Asset Manager server artifacts to the application server.

Creating and configuring a database for Rational Asset Manager
If your database software is installed and the database server is running, you can create and configure a
database either prior to installing Rational Asset Manager, or while using the Rational Asset Manager
server setup application (after Rational Asset Manager has been installed). If you are using DB2, the
server setup application can create and configure the database for you.

If you choose to create and configure your database through the Rational Asset Manager server setup
application, skip this section and proceed to “Installing and configuring Rational Asset Manager using
Installation Manager and the server setup application” on page 31.

Manually configuring and creating tables in DB2 using database
scripts (Windows and Linux only)
These are the instructions for Windows and Linux only for creating and populating tables in DB2 for
Rational Asset Manager.

Before you begin

You can create the database and tables automatically by running batch files. DB2 must already be
installed and running. Ensure that you know the location of the SQL scripts (typically, path to installation
media\ db_scripts\DB2). Finally, ensure that you also know the installation directory for DB2 (typically
C:\Program Files\IBM\SQLLIB for Windows and opt/IBM/DB2/V9.5 for Linux.

About this task

Note: This method is not supported for AIX. Instead, follow the instructions described in the topic
“Manually configuring and creating tables in DB2” on page 44.
1. If you are installing from the CD, then copy the SQL scripts to your local file system.
2. For Linux: Check that you have write permission for the directory containing the SQL scripts.
3. In a command line, change to the directory containing the SQL scripts for DB2 (path to installation

media\ db_scripts\DB).
4. Run db2create_populate.bat (for Windows) or db2create_populate.sh (for Linux).
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5. When prompted, enter the name of the database or press the Enter key to accept the default database
name (RAMDB).

6. At the next prompt, enter the installation directory path for DB2, or press the Enter key to accept the
default value (C:\Program Files\IBM\SQLLIB for Windows, and /opt/IBM/DB2/V9.5 for Linux.

7. The batch file runs. The script performs the following actions:
v A database with the name that you entered is created.
v Tablespace is configured for the database.
v Tables and schema for RAM are created in the database.

Note: When you run the batch file for the first time, you might see a number of SQL0204N error
messages that name is an undefined name, and they will be similar to the following example:
** CLI error in executing the SQL statement:
(-204): [IBM][CLI Driver][DB2/NT] SQL0204N "RAMSCHEMA.FORUM" is an undefined name. SQLSTATE=42704

If you are running the batch file for the first time, then you can safely ignore these messages.
8. Verify that the tables were created. For example, start the DB2 Control Center and browse for the

RAMDB database. Verify that the database and tables were created.

Manually configuring and creating tables in DB2
These are the instructions for manually configuring DB2 and creating and populating tables for Rational
Asset Manager in DB2. Follow these instructions if you cannot run the batch files used in the preceding
instructions (for example, if you are running AIX).

Before you begin

DB2 must already be installed and running. Also, make sure that you know the location of the SQL
scripts (typically, path to installation media\ db_scripts\DB2). Finally, ensure that you also know the
installation directory for DB2 (typically C:\Program Files\IBM\SQLLIB for Windows, opt/ibm/DB2/V9.5
for Linux and /opt/IBM/db2/V9.5 for AIX.

About this task

To configure DB2 and create the database tables:
1. Start the DB2 Control Center.
2. Select the instance of the database.
3. Create and add a new database.

a. Click Tools → Command Editor.
b. In the command editor, type (in uppercase):

ATTACH TO <DATABASE_INSTANCE>

(where <DATABASE_INSTANCE> is the name of the database instance you selected in step 2)
c. Click Execute.
d. Clear the previous command from the command editor and type (in uppercase):

CREATE DATABASE <DATABASE_NAME> AUTOMATIC STORAGE YES USING CODESET UTF-8 TERRITORY US

(where <DATABASE_NAME> may be any name you choose; for example, RAMDB)
e. Click Execute.
f. Click Add, select the database you just created, and click OK.

4. Execute the dbcreate.sql script.
a. Click Open.
b. Navigate to the dbcreate.sql file.
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c. Click OK.
d. Click Yes.
e. Click Execute.

5. Execute the RAMSCHEMA_DB2.sql script.
a. Click Open.
b. Navigate to the RAMSCHEMA_DB2.sql file.
c. Click OK.
d. Click Yes.
e. In the Statement termination character text field, in place of the default semi-colon character ( ; ),

type a caret ( ^ ).
f. Click Execute.

6. Execute the bootstrap_DB2.sql script.
a. Click Open.
b. Navigate to the bootstrap_DB2.sql file.
c. Click OK.
d. Click Yes.
e. In the Statement termination character text field, in place of the caret ( ^ ), type a semi-colon ( ; ).
f. Click Execute.

7. Verify that the tables were created.
a. Click Object View and open the database instance.
b. Click Tables to verify that the tables contain data.

Creating and configuring a database in Oracle 11g or 10.2(g)
These are the instructions for manually creating and populating tables for Rational Asset Manager in
Oracle 11g or 10.2(g).

Before you begin

Oracle must already be installed and running. Also, make sure that you know the location of the SQL
scripts (typically, path to installation media \db_scripts\Oracle).

About this task

To create the database tables:
1. Using the Oracle Database Configuration Assistant, follow the steps in the wizard to create a new

database.
a. Use global database name ramdb_<your domain>, and a system identifier (SID) ramdb.
b. On the Custom Scripts tab, do not run the SQL scripts that are mentioned in the later steps. You

must create a user account first.
c. On the Character Sets page, select Use Unicode (AL32UTF8).
d. Also on the Character Sets page, for National Character Set, select UTF8 - Unicode 3.0 UTF-8.
e. Complete the other pages in the wizard, accepting the default values.

2. Create a database user.
a. Open Database Control.
b. Navigate to the Users page. (In Oracle 10.2(g), click Administration, then Users; in Oracle 11(g),

click Server, then click Users in the Security section.)
c. Create a user named RAMSCHEMA that meets the following qualifications:

v The user has the resource and connect roles.
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v The user’s quota setting is unlimited.
v For tablespace, you can use any default tablespace (with the exception of Temp) that meets the

access level requirements for the user that you created.

Tip: Oracle provides a default user named ″Scott″ that has the appropriate permissions. You can
use this default user as the basis for your new user account.

3. Run the scripts that will populate the database. (This step is not necessary if you are using the server
setup application; the server setup application will run the scripts for you.)
a. Click SQL+ to open it.
b. Open the RAMSCHEMA_Oracle.sql file in the sqlscripts/oracle folder. Highlight the entire

contents of the file, copy them (right-click, and then Copy), and then paste them into the top of
the SQL+.

c. Click Execute. When the process finishes, delete the commands from the top window.
d. Repeat these steps for the bootStrap_Oracle.sql file.

4. Verify that the tables were created.

Creating and configuring a database in Microsoft SQL Server 2005
These are the instructions for manually creating and populating tables for Rational Asset Manager in
Microsoft SQL Server 2005.

Before you begin

SQL Server 2005 must already be installed and running. Also, make sure that you know the location of
the SQL scripts (typically, path to installation media \db_scripts\SQLServer).

About this task

To create the database tables:
1. Ensure that your ID has permission to execute CREATE SCHEMA statements. (Typically, the database

owner has this permission.)
2. Create a new database with database name RAMDB.
3. Execute the scripts that will populate the database.

a. Open a command prompt.
b. Type sqlcmd -d RAMDB -i path to SQL scripts\RAMSCHEMA_SQLServer.sql (where RAMDB is the

name of the database that you created in step 2), and press Enter.
c. Type sqlcmd -d RAMDB -i path to SQL scripts\bootStrap_SQLServer.sql (where RAMDB is the

name of the database that you created in step 2), and press Enter.
4. Verify that the tables were created.

Retrieving Rational Asset Manager applications from the installation
media
To retrieve the Rational Asset Manager enterprise and Web archive files from the installation media, you
can run the Installation Manager from the launchpad and choose to do a manual installation instead of
installing with embedded WebSphere Application Server or to an existing WebSphere Application Server.

Retrieving the Rational Asset Manager server application for Windows,
Linux, or AIX from the installation media with Installation Manager
To install IBM Rational Asset Manager server on an existing application server on Windows, Linux, or
AIX, use IBM Installation Manager to first obtain the EAR or WAR files for the server application from
the installation media.

46 IBM Rational Asset Manager, version 7.1.1.1 : Installation guide



Before you begin

To obtain the EAR or WAR files for the server application:
1. Start the Rational Asset Manager launchpad program (see “Installing from the launchpad program”

on page 25) and then select IBM Rational Asset Manager. If Installation Manager is not already
installed, follow the steps in the installation wizard to complete the installation. The Install Packages
wizard opens. Installation Manager is required for this procedure.

2. The Install page of Install Packages wizard lists all the packages that are found in the repositories
that Installation Manager searches. If two versions of a package are discovered, only the most
appropriate version of the package is displayed.

3. To search for updates to the IBM Rational Asset Manager server package, click Check for Other
Versions and Extensions.

Note: For Installation Manager to search the predefined IBM update repository locations for the
installed packages, the preference Search service repositories during installation and updates on
the Repositories preference page must be selected. This preference is selected by default. Internet
access is also required.
Installation Manager searches for updates at the predefined service repository for the product
package. It also searches any repository locations that you have set. A progress indicator shows the
search is taking place. You can install updates at the same time that you install the base product
package.

4. If updates for the IBM Rational Asset Manager server package are found, then they will be displayed
in the Installation Packages list on the Install Packages page following their corresponding product.
Only the most appropriate updates are displayed by default.

5. Select Rational Asset Manager server and any updates to the package that you want to install.
Updates that have dependencies are automatically selected and cleared together.

6. Click Next to continue.

Note: If you install multiple packages at the same time, then all the packages will be installed into
the same package group.

7. On the Licenses page, read the license agreement for the selected package. If you selected more than
one package to install, there might be a license agreement for each package. On the left side of the
License page, click each package version to display its license agreement. The package versions that
you selected to install (for example, the base package and an update) are listed under the package
name.
a. If you agree to the terms of each license agreement, click I accept the terms of the license

agreements.
b. Click Next to continue.

8. If you are installing the first package on this computer, then on the Location page, type the path for
the shared resources directory in the Shared Resources Directory field; or accept the default path. The
shared resources directory contains resources that can be shared by one or more package groups.
Click Next to continue.
The default path is:
v For Windows: C:\Program Files\IBM\IBMIMShared
v For Linux and AIX: /opt/IBM/IBMIMShared

Important: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this to help ensure adequate space for the shared resources of
future packages. You cannot change the directory location unless you uninstall all packages.

9. On the Location page, either choose an existing package group to install the IBM Rational Asset
Manager server package into, or create a new one. A package group represents a directory in which
packages share resources with other packages in the same group. To create a new package group:
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a. Click Create a new package group.
b. Type the path for the installation directory for the package group. This is the directory where the

Rational Asset Manager application files for manual installation will be created. The name for the
package group is created automatically.
The default path is:
v For Windows: C:\Program Files\IBM\RAM71Server
v For Linux and AIX: /opt/IBM/RAM71Server

c. Click Next to continue.
10. On the Features page under Languages, select the languages for the package group. The

corresponding national language translations for the user interface and documentation for the IBM
Rational Asset Manager server package will be installed. Note that your choices apply to all
packages installed under this package group.

11. On the next Features page, select Rational Asset Manage, Asset-based Development and
Governance Process, and Rational Asset Manager Help and Documentation Web Archive. They
should be selected by default. Click Next.

12. On the Select Application Server page, from the Select application server list, select Manual; then,
click Next.

13. On the Summary page, review your choices before installing the package. If you want to change the
choices or configuration details that you made on previous pages, click Back and make your
changes.

14. When you are satisfied with your installation choices, click Install to install the package. A progress
indicator shows the percentage of the installation completed.

15. When the installation process is complete, a message confirms the success of the process. Click
Finish to return to the Start page of Installation Manager.

What to do next

The EAR and WAR files for installing the IBM Rational Asset Manager server application on an existing
WebSphere Application Server are now available in the directory <installation directory>\ram\apps.

Table 2. Locations of downloaded files

Path File names Description

installation directory\ram\apps\was v com.ibm.ram.repository.web_runtime.ear

v com.ibm.ram.repository.setup.web.ear

v Rational Asset
Manager
Enterprise Archive
for WebSphere
Application Server

v Rational Asset
Manager Server
Setup Enterprise
Archive

installation directory\ram\apps\
tomcat

v com.ibm.ram.repository.web.tomcat_runtime.war

v com.ibm.ram.repository.web.ws.tomcat_runtime.war

Rational Asset
Manager Web
Archive for Tomcat

installation directory\ram\apps\
WAR

rmcabdgovernprocess.war Asset-based
Development and
Governance process

installation directory\ram\apps iehs.war Rational Asset
Manager Help and
Documentation web
archive
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Retrieving the Rational Asset Manager server application from the
installation media for Linux for zSeries
To install IBM Rational Asset Manager server for Linux for zSeries on an existing application server, you
can manually obtain the EAR or WAR files for the server application from the installation media.

Before you begin

For Linux for zSeries, The .ear or .war files for the server application must be manually copied from the
CD or disk image of Rational Asset Manager to a local disk image. The Rational Asset Manager files are
in the following locations:

Table 3. Locations of installation files for Rational Asset Manager server for Linux for zSeries

Path File names Description

disk root\apps\was v com.ibm.ram.repository.web_runtime.ear

v com.ibm.ram.repository.setup.web.ear

v Rational Asset
Manager
Enterprise Archive
for WebSphere
Application Server

v Rational Asset
Manager Server
Setup Enterprise
Archive

disk root\apps\tomcat v com.ibm.ram.repository.web.tomcat_runtime.war

v com.ibm.ram.repository.web.ws.tomcat_runtime.war

Rational Asset
Manager Web
Archive for Tomcat

disk root\apps\WAR rmcabdgovernprocess.war Asset-based
Development and
Governance process

disk root\apps iehs.war Rational Asset
Manager Help and
Documentation web
archive

Manually deploying Rational Asset Manager server setup to a cluster
To manually deploy the Rational Asset Manager server setup application to a cluster, it is necessary to
run a Jython script. If you used Installation Manager to install Rational Asset Manager to a cluster,
Installation Manager performed this step.

Before you begin

Before running these scripts, you must have used Installation Manager and selected to do a manual
installation.
1. Locate the following scripts in the <Rational_Asset_Manager_install_directory>\ram\conf\bin folder:

v deployClusterSetup.py
v UninstallSetup.py

2. To deploy Rational Asset Manager server setup enterprise archive to the cluster, run the following
command (Windows):
wsadmin.bat -lang jython -user <user_name> -password <password> -f <install_dir>\ram\conf\bin\deployClusterSetup.py <install_dir>/ram/apps/was/com.ibm.ram.repository.se

On AIX or Linux, run the following command:
wsadmin.sh -lang jython -user <user_name> -password <password> -f <install_dir>/ram/conf/bin/deployClusterSetup.py <install_dir>/ram/apps/was/com.ibm.ram.repository.set
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where:
v <user_name> is the name of a WebSphere Application Server administrator
v <password> is the administrator’s password
v <install_dir> is the Rational Asset Manager installation directory
v <server_name> is the name of the server; for example, RAMCluster
v <context_root> is the context root of the server setup application; for example,

com.ibm.ram.repository.setup.web or ram.setup

Example

Note: The path to the Python script should contain backslashes on Windows and forward slashes on AIX
and Linux. The path to the EAR file should contain forward slashes, regardless of platform.

What to do next

To uninstall it from the cluster, run the following command (Windows):
wsadmin.bat -conntype NONE -lang jython -f <installdir>\ram\conf\bin\UninstallSetup.py com.ibm.ram.repository.setup.web.ear

On AIX or Linux, run the following command:
wsadmin.sh -conntype NONE -lang jython -f <installdir>/ram/conf/bin/UninstallSetup.py com.ibm.ram.repository.setup.web.ear

Installing Rational Asset Manager server manually on WebSphere
Application Server
About this task

You can manually install the Rational Asset Manager server on an existing WebSphere Application Server
installation.

Configuring file-based security
When initially installed, the Rational Asset Manager server application uses file-based security for user
authentication. If you perform the installation scenario where you install the Rational Asset Manager
server with an embedded WebSphere Application Server, the Installation Manager will automatically
configure this for you.

To install Rational Asset Manager onto an existing WebSphere Application Server you must configure
file-based security yourself.

Important: If you install Rational Asset Manager onto an existing WebSphere Application Server that is
already configured for security (for example, using LDAP), then you must reconfigure the application
server for file-based security until the installation and configuration of Rational Asset Manager is
complete. After installing and configuring the server application to use a custom user registry, you can
restore WebSphere Application Server security configuration. File-based security is not intended for
production environments.

Configuring file-based security on WebSphere Application Server V6.1
You can authenticate users for Rational Asset Manager using file-based security on your local operating
system. These instructions are for configuring file-based security on WebSphere Application Server V6.1.

Before you begin

Before starting, note the location of the files named users.props and groups.props. The install process
places these in WebSphere Application Server install root/ram/conf/security.
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1. Start the server and open the administrative console.
a. Open a command window and change to WAS_PROFILE/bin directory.
b. Type startServer.bat server1.
c. When the server has started, open a web browser and go to http://localhost:13060/ibm/console.

(This port number might be different than 13060; to check, look in WAS_PROFILE/properties/
portdef.props for the value of the WC_adminhost property and use it instead) If security is
enabled, use https://localhost:13043/ibm/console. (This port number might be different than
9043; to check, look in WAS_PROFILE/properties/portdef.props for the value of the
WC_adminhost_secure property and use it instead.)

2. Click Security.
3. Click Secure administration, applications, and infrastructure.
4. Under Available realm definitions, select Standalone custom registry and click Configure.

5. Click Custom Properties.
6. Click New.
7. In the Name field, type groupsFile.
8. In the Value field, type the path to the groups.props file.
9. Click Apply.

10. Click OK.
11. Click New.
12. In the Name field, type usersFile.
13. In the Value field, type the location of the users.props file.
14. Click Apply.
15. Click Standalone custom registry at the top of the page.
16. Click Save.
17. In the Primary administrative user name, Server user ID and Password fields, type admin.
18. Click OK.
19. On the Configuration page, select Enable administrative security and disable Use Java 2 security....
20. Ensure Enable application security remains checked.
21. Ensure that Available realm definitions is set to Standalone custom registry.
22. Click Set as current.
23. Click Apply.
24. Click Save.
25. Log out of the administrative console.
26. Restart the server or restart the computer. If you are using a clustered environment, restart the server

or restart the computer where the Domain Manager (DM) is located.

Configuring database connections
This section describes creating a connection between the database and WebSphere Application Server.

Configuring a database connection between WebSphere Application Server V6.1
and DB2
You can manually create a database connection between WebSphere Application Server V6.1 and the
database tables created for Rational Asset Manager in DB2.

About this task

If you work in a clustered server environment, use the WebSphere Administrative Console on the
Domain Manager (DM) for all WebSphere Application Server Console steps.
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1. Start the WebSphere Administrative Console.
2. Log in using the user ID admin and the password admin (defined in the section ″Configuring

security,″ above).
3. If DB2 and WebSphere Application Server are not installed on the same server, make sure that DB2

Agent Installer is installed with WebSphere Application Server in order to communicate with a
remote installation of DB2.

4. Create a database connection
a. Click Resources in the navigation pane.
b. Click JDBC.
c. Click JDBC Providers.

5. Create a JDBC Provider.
a. Click New.
b. For the database type, select DB2

c. For the provider type, select DB2 Universal JDBC Driver.
d. For the implementation type, select Connection pool data source.
e. Click Next.
f. On the Enter database class path information page, type the path to the DB2 java directory in the

Directory location field.
g. Click Next.
h. Click Finish.
i. On the JDBC Providers page, click Save.

6. Bind the database to a JNDI name.
a. Click the DB2 Universal JDBC Driver Provider link.
b. Under Additional Properties, click Data sources.
c. Click New.
d. In the JNDI name field, type jdbc/RAM_Con.
e. Click Next.
f. In the Database name field, type the name of the database.
g. In the Server name field, type the name of the server.
h. Click Next.
i. Click Finish.

7. Set up J2C authentication.
a. On the JAAS-J2C authentication data page, enter the Alias, User ID and Password for

authentication to the DB2 database.
b. Click DB2 Universal JDBC Driver Provider.
c. Select node_name/db2admin (or the name that you created for your JAAS-J2C authentication

alias). In normal circumstances, the authentication alias is prefixed with the node name.
d. Click OK.
e. Click Save.

8. Log out of the console.
9. Restart the server.

10. In a clustered environment, the Domain Manager (DM) must be restarted.

Configuring a database connection between WebSphere Application Server and
Oracle
You can manually create a database connection between WebSphere Application Server V6.1 or V6.0.2
and the database tables created for Rational Asset Manager in Oracle 11g or 10.2(g).
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About this task

If you work in a clustered server environment, use the WebSphere Administrative Console on the
Domain Manager (DM) for all WebSphere Administrative Console steps.
1. Ensure that the odbc14.jar file is from Oracle 10g (10.2) or later. Older versions of this file will not

work. If necessary, copy the needed version of the file to a folder on the WebSphere Application
Server server (for example, D:\Oracle).

2. Start the WebSphere Administrative Console.
3. Log in using the user ID admin and the password admin (defined in the earlier section ″Configuring

security,″ above).
4. Set up the Oracle driver path.

a. Click Environment in the navigation pane.
b. Click WebSphere Variables.
c. Click New.
d. In the Name field, selectOracle_JDBC_DRIVER_PATH

e. In the Value field, select the path to the Oracle library with the required version of the
ojdbc14.jar file (for example, D:\Oracle.)

f. Click Apply.
g. Click OK.

5. Set up J2C authentication.
a. Click Security.
b. Click Global Security.
c. In the Authentication section of the Global Security window, click JAAS Configuration.
d. Click J2C Authentication Data.
e. Click New.
f. In the Alias Entry field, type RAM_Con.
g. In the User ID field, type an Oracle user ID with administration privileges. For Oracle, the user

ID defined here must be the name given to the schema (for example, ramschema).
h. In the Password field, type the password for the user ID.
i. Click Apply.
j. Click OK.

6. Create a database connection
a. Click Resources in the navigation pane.
b. Click JDBC Providers.
c. If you use a remote installation of DB2, make sure the Node and Server entries are cleared and

click Apply.
d. If you work in a clustered environment, type the name of the cluster in the Cluster field and

click Apply.
7. If any other JDBC drivers have been defined for Rational Asset Manager (for example, JNDI Name =

jdbc/RAM_Con), delete those drivers before completing the following steps.
8. Create a JDBC Provider.

a. Click New.
b. For the database type, select Oracle.
c. For the provider type, select Oracle JDBC Driver.
d. For the implementation type, select Connection pool data source.
e. Click Next.
f. Click Apply.
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g. Click Data sources.
h. Click New.

9. Bind the database to a JNDI name.
a. In the JNDI name field, type jdbc/RAM_Con.
b. For the Data store helper class name, select the level of Oracle installed (for example, Oracle 9i

and prior data store helper).
c. For the Component-managed authentication alias field, select the J2C authentication that you

created earlier.
d. For the URL field, type the path that the Oracle administrator provides. It will have the

following form:
jdbc:oracle:thin:@fully_qualified_machine_name:oracle_port_number:database_name.

e. Click Apply.
f. Click OK.
g. Click Test Connection.

10. Save the WebSphere Application Server configuration.
a. Click Save at the top of the window.
b. In the next window, click Save.

11. Log out of the console.
12. Restart the server.
13. In a clustered environment, the Domain Manager (DM) must be restarted.

Configuring a database connection between WebSphere Application Server V6.1
and Microsoft SQL Server 2005
You can manually create a database connection between WebSphere Application Server V6.1 and the
database tables that are created for Microsoft SQL Server 2005.

About this task

If you work in a clustered server environment, use the WebSphere Administrative Console on the
Domain Manager (DM) for all WebSphere Application Server Console steps.
1. Start the WebSphere Administrative Console.
2. Log in using the user ID admin and the password admin (defined in the earlier section ″Configuring

security″).
3. Click Environment → WebSphere Variables. The WebSphere Variables page opens.
4. Click MSSQLSERVER_JDBC_DRIVER_PATH. The MSSQLSERVER_JDBC_DRIVER_PATH page

opens.
5. In the Value field, type the path to the directory that contains the Microsoft JDBC driver for

MSSQLServer 2005(sqljdbc.jar), and then click OK.
6. Click Resources → JDBC Providers, and then, in the JDBC Providers page that opens, click New.
7. Create a JDBC provider.

a. In the JDBC providers page, click New.
b. For the database type, select User-defined.
c. For Implementation class name, type com.microsoft.sqlserver.jdbc.SQLServerXADataSource.
d. For Name, type Microsoft SQL Server 2005 JDBC provider.
e. Click Next.
f. For Class path, type ${MSSQLSERVER_JDBC_DRIVER_PATH}/sqljdbc.jar.
g. Click Finish.

8. Bind the database to a JNDI name.
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a. On the JDBC providers page, click Microsoft SQL Server 2005 JDBC provider (the link for the
JDBC provider that you created in the previous step).

b. Under Additional Properties, click Data sources.
c. Click New.
d. In the Data source name field, type Microsoft SQLServer 2005 JDBC RAM.
e. In the JNDI name field, type jdbc/RAM_Con.
f. Click Next.
g. For Data store helper class name, type

com.ibm.websphere.rsadapter.ConnectJDBCDataStoreHelper

h. Click Next and then click Finish.
i. On the Microsoft SQLServer 2005 JDBC RAM data source page, under Additional Properties,

click Custom Properties.
j. On the Custom properties page, click New.
k. In the Name field, type databaseName, and in the Value field type RAMDB or the name that you

used for the database.
l. Click OK. You return to the Custom properties page.
m. Add another custom property for the server name. Click New. In the Name field, type

serverName, and in the Value field type your server name (for example, myserver.com), and then
click OK.

n. Add another custom property for the port number. Click New. In the Name field, type
portNumber, and in the Value field type your port number (the default is usually 1443), and then
click OK.

o. Click OK. You return to the Custom properties page.
9. Set up J2C authentication.

a. Click the link Microsoft SQLServer 2005 JDBC RAM near the top of the page.
b. Under Related items, click JAAS-J2C authentication data.
c. Click New.
d. Enter the Alias, User ID and Password for authentication to the Microsoft SQL Server 2005

database.
e. Click OK.
f. Click the link Microsoft SQLServer 2005 JDBC RAM near the top of the page.
g. Under Container-managed authentication, select the entry that is the name that you created for

your JAAS-J2C authentication alias. The node name is usually prefixed to the name of the
authentication alias.

h. Click OK.
i. Click Save.

10. Log out of the console.
11. Restart the server.
12. In a clustered environment, the Domain Manager (DM) must be restarted.

Deploying Rational Asset Manager server on WebSphere Application
Server
This section describes deploying the Rational Asset Manager server application on WebSphere
Application Server.

Deploying Rational Asset Manager on WebSphere Application Server V6.1
You can manually install Rational Asset Manager on an existing installation of WebSphere Application
Server V6.1.
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Before you begin

If installing the product into a clustered environment, use the WebSphere Administrative Console on the
Domain Manager (DM) for all administrative console steps.
1. Locate the Rational Asset Manager Enterprise Archive for WebSphere Application Server file

com.ibm.ram.repository.web_runtime.ear. Refer to “Retrieving the Rational Asset Manager server
application for Windows, Linux, or AIX from the installation media with Installation Manager” on
page 46 or “Retrieving the Rational Asset Manager server application from the installation media for
Linux for zSeries” on page 49 to locate this file.

2. Launch the WebSphere Administrative Console.
3. Click Applications.
4. Click Enterprise Applications.
5. Click Install.
6. Type the path and file name of the Rational Asset Manager Server EAR file.
7. Click Show me all installation options and parameters.
8. Click Next until you reach Step 6: Map Resource references to resources, or select this step in the

navigation pane.
9. On the page titled Map Resource References to resources, perform the following steps:

a. In the javax.sql.DataSource section, select both modules in the table.
b. Under Specify authentication method in the same section, select Use default method

(many-to-one mapping) and under Authentication data entry select node_name/RAM_Con from
the menu.

c. Under JNDI names, select jdbc/RAM_Con and click Apply.
d. In the section javax.sql.DataSource under Specify Authentication Data Entry, select Use Default

Method and select node_name/RAM_Con from the menu.
e. Click Apply.
f. Click Next.

Note: A page might display with a series of warnings that resource assignments
(jms/RAM_Factory, jms/RAM_Cache, url/RAM_Local, and url/RAM_Persist) are missing for
resource references. You can safely ignore these warnings. Click Continue.

10. Click Next on the next three pages, or click Step 10 in the navigation pane.
11. On the page titled Summary, click Finish.
12. When the installation of the EAR file finishes, click Save to Master Configuration.
13. Click Save.
14. Install the Rational Asset Manager Help and Documentation web archive:

a. Click Applications → Enterprise Applications.
b. Click Install.
c. In the Specify path field, type the path and file name of the Rational Asset Manager Help and

Documentation WAR file iehs.war. Refer to “Retrieving the Rational Asset Manager server
application for Windows, Linux, or AIX from the installation media with Installation Manager”
on page 46 or “Retrieving the Rational Asset Manager server application from the installation
media for Linux for zSeries” on page 49 to locate this file.

d. In the Context root field, type help for the context root.
e. Click Next until you reach Step 3: Map virtual hosts for Web modules. Select the Web module

and click Next.
f. On the page titled Summary, click Finish.
g. When the installation of the WAR file finishes, click Save to Master Configuration.
h. Click Save.
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15. Install the Asset-based Development and Governance process web archive:
a. Click Applications → Enterprise Applications.
b. Click Install.
c. In the Specify path field, type the path and file name of the Asset-based Development and

Governance process WAR file rmcabdgovernprocess.war. Refer to “Retrieving the Rational Asset
Manager server application for Windows, Linux, or AIX from the installation media with
Installation Manager” on page 46 or “Retrieving the Rational Asset Manager server application
from the installation media for Linux for zSeries” on page 49 to locate this file.

d. In the Context root field, type com.ibm.ram.repository.web/abdprocess for the context root.
e. Click Next until you reach Step 3: Map virtual hosts for Web modules. Select the Web module

and click Next.
f. On the page titled Summary, click Finish.
g. When the installation of the WAR file finishes, click Save to Master Configuration.
h. Click Save.

16. Start the application.
a. In the navigation pane, click Applications.
b. Click Enterprise Applications.
c. Select the newly installed Rational Asset Manager application and click Start.

17. If Rational Asset Manager is accessed through the IIS or Apache server, perform the following steps;
if Rational Asset Manager is accessed without a Web server front end, skip this step.
a. In the navigation pane, click Servers.
b. Click Web Servers.
c. Select the Web server name and click Generate Plug-in. (If the Web server plug-in has never been

created, refer to Installing Web server plug-ins.)
d. Check the Web server name again and click Propagate Plug-in. This sends the plug-in to the Web

server so that the Rational Asset Manager Server application can be referenced through the
installed Web server.

18. Restart WebSphere Application Server and Web servers.
19. Use the following URLs to access Rational Asset Manager.

a. If you use a Web server, type http://machine_name/com.ibm.ram.repository.web/home.faces.
b. If you do not use a Web server, type http://machine_name:13080/com.ibm.ram.repository.web/

home.faces. (If this URL does not work, use the port number for the Default Host that is defined
in Virtual Hosts under Environment in the navigation pane.)

20. Configure the Rational Asset Manager server application. Refer to “Configuring the Rational Asset
Manager server application” on page 62.

Installing Rational Asset Manager server on Tomcat
About this task

You can manually install Rational Asset Manager on an existing installation of Apache Tomcat.

Deploying Rational Asset Manager on Apache Tomcat V5.5 connected
to DB2
Rational Asset Manager can be installed manually on an existing installation of Apache Tomcat. These
instructions are for deploying Rational Asset Manager on Tomcat V5.5.

Before you begin

Tomcat server must be installed and running.
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1. Locate the Rational Asset Manager server WAR files. The installer places these files in Rational Asset
Manager install root/tomcat

2. Start the Tomcat Manager: open http://localhost:8080/manager/html.
3. Configure Tomcat to access DB2.

a. Open the file TOMCAT_INSTALL_PATH\conf\server.xml in a text editor.
b. Locate any lines in server.xml that begin with <Connector and contain port="8080"

orport="8009". Change the start of this line to <Connector URIEncoding="UTF-8".
c. Between the opening and closing tags for Global JNDI resources <GlobalNamingResources> and

</GlobalNamingResources> in server.xml, enter the text below for your version Tomcat.

Note: For the values your_username and your_password, use a userid and password that has
access to the database. The values shown for ″maxWait,″ “maxActive″ and ″maxIdle″ are sample
values and can be adjusted according to your performance needs.

Type:
<Resource name="jdbc/RAM_Con"
type="javax.sql.DataSource"
driverClassName="com.ibm.db2.jcc.DB2Driver"
username="your_username"
password="your_password"
url=" jdbc:db2://fully_qualified_server_name:db2_port_number/database_name "
poolPreparedStatements="true"
maxWait="5000"
maxActive="4"
maxIdle="2"/>

4. Configure Tomcat server for security.
a. Edit the file Tomcat_install_path\conf\tomcat-users.xml.
b. Add user IDs that are required for authentication.

5. Copy the following JAR files from the DB2 installaton location\java folder of your DB2 installation to
the Tomcat_install_path\common\lib folder:
v db2jcc_license_cu.jar
v db2jcc.jar

6. Restart Tomcat server.
7. Install the Rational Asset Manager WAR files on Tomcat server:

a. Open Tomcat Manager (http://localhost:8080/manager/html) and log with the correct userID
and password for administrator.

b. In the Select WAR file to upload field at the bottom of the Tomcat Web Application Manager
page under WAR file to deploy, browse to the location where you retrieved the file
com.ibm.ram.repository.web.tomcat_runtime.war from the installation media. Refer to “Retrieving
the Rational Asset Manager server application for Windows, Linux, or AIX from the installation
media with Installation Manager” on page 46 or “Retrieving the Rational Asset Manager server
application from the installation media for Linux for zSeries” on page 49 to locate this file.

c. Click Deploy.
d. Repeat the previous steps to deploy the com.ibm.ram.repository.web.ws.tomcat_runtime.war file,

entering this file as the WAR file to upload.
e. The WAR files are displayed in the list of applications

8. Install the Rational Asset Manager help WAR file on Tomcat server:
a. In Tomcat Manager in the section Deploy directory or WAR file located on server, enter the

location where you retrieved the file iehs.war from the installation media in the field WAR or
Directory URL. Refer to “Retrieving the Rational Asset Manager server application for Windows,
Linux, or AIX from the installation media with Installation Manager” on page 46 or “Retrieving
the Rational Asset Manager server application from the installation media for Linux for zSeries”
on page 49 to locate this file.
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b. Type /help in the Context Path (optional) field.
c. Click Deploy.
d. The WAR file is displayed in the list of applications

9. Install the Rational Asset Manager Asset-based Process Governance documentation WAR files on
Tomcat server:
a. In Tomcat Manager in the section Deploy directory or WAR file located on server, enter the

location where you retrieved the file rmcabdgovernprocess.war from the installation media in the
field WAR or Directory URL. Refer to “Retrieving the Rational Asset Manager server application
for Windows, Linux, or AIX from the installation media with Installation Manager” on page 46 or
“Retrieving the Rational Asset Manager server application from the installation media for Linux
for zSeries” on page 49 to locate this file.

b. Type /abdprocess in the Context Path (optional) field,
c. Click Deploy.
d. The WAR file is displayed in the list of applications

10. Open Rational Asset Manager using Tomcat (http://localhost:8080/com.ibm.ram.repository.web/
home.faces) or through a Web server (http://Webserver_Name/com.ibm.ram.repository.web/
home.faces).

Deploying Rational Asset Manager on Apache Tomcat V5.5 connected
to Oracle
Rational Asset Manager can be installed manually on an existing installation of Apache Tomcat. These
instructions are for deploying Rational Asset Manager on Tomcat V5.5.

Before you begin

Tomcat must be installed and running.
1. Locate the Rational Asset Manager Server WAR files. The installer places these files in <Rational Asset

Manager install root>/tomcat.
2. Launch the Tomcat Manager: open http://localhost:8080/manager/html.
3. Configure Tomcat server to access Oracle.

a. Open the file TOMCAT_INSTALL_PATH\conf\server.xml in a text editor.
b. Locate any lines in server.xml that begin with <Connector and contain port="8080"

orport="8009". Change the start of this line to <Connector URIEncoding="UTF-8".
c. Between the opening and closing tags for Global JNDI resources <GlobalNamingResources> and

</GlobalNamingResources> in server.xml, enter the text below for your version Tomcat.

Note: For the values your_username and your_password, use a userid and password that has
access to the database. The values shown for ″maxWait,″ “maxActive″ and ″maxIdle″ are sample
values and can be adjusted according to your performance needs.

Type:
<Resource name="jdbc/RAM_Con"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="your_username"
password="your_password"
url="jdbc:oracle:thin:@fully_qualified_machine_name:oracle_port_number:database_name"
poolPreparedStatements="true"
maxWait="5000"
maxActive="4"
maxIdle="2"/>

4. Configure Tomcat server for security.
a. Edit Tomcat_install_path\conf\tomcat-users.xml.
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b. Add user IDs that are required for authentication.
5. Add the following JAR file to the Tomcat_install_path\common\lib folder:

v ojdbc14.jar

This file should be available from your database application provider.
6. Restart Tomcat.
7. Install the Rational Asset Manager WAR files on Tomcat server:

a. Open Tomcat Manager (http://localhost:8080/manager/html) and log with the correct userID
and password for administrator.

b. In the Select WAR file to upload field at the bottom of the Tomcat Web Application Manager
page under WAR file to deploy, browse to the location where you retrieved the file
com.ibm.ram.repository.web.tomcat_runtime.war from the installation media. Refer to “Retrieving
the Rational Asset Manager server application for Windows, Linux, or AIX from the installation
media with Installation Manager” on page 46 or “Retrieving the Rational Asset Manager server
application from the installation media for Linux for zSeries” on page 49 to locate this file.

c. Click Deploy.
d. Repeat the previous steps to deploy the com.ibm.ram.repository.web.ws.tomcat_runtime.war file,

entering this file as the WAR file to upload.
e. The WAR files are displayed in the list of applications

8. Install the Rational Asset Manager help WAR file on Tomcat server:
a. In Tomcat Manager in the section Deploy directory or WAR file located on server, enter the

location where you retrieved the file iehs.war from the installation media in the field WAR or
Directory URL. Refer to “Retrieving the Rational Asset Manager server application for Windows,
Linux, or AIX from the installation media with Installation Manager” on page 46 or “Retrieving
the Rational Asset Manager server application from the installation media for Linux for zSeries”
on page 49 to locate this file.

b. Type /help in the Context Path (optional) field.
c. Click Deploy.
d. The WAR file is displayed in the list of applications

9. Install the Rational Asset Manager Asset-based Process Governance documentation WAR files on
Tomcat server:
a. In Tomcat Manager in the section Deploy directory or WAR file located on server, enter the

location where you retrieved the file rmcabdgovernprocess.war from the installation media in the
field WAR or Directory URL. Refer to “Retrieving the Rational Asset Manager server application
for Windows, Linux, or AIX from the installation media with Installation Manager” on page 46 or
“Retrieving the Rational Asset Manager server application from the installation media for Linux
for zSeries” on page 49 to locate this file.

b. Type /abdprocess in the Context Path (optional) field,
c. Click Deploy.
d. The WAR file is displayed in the list of applications

10. Open Rational Asset Manager using Tomcat (http://localhost:8080/com.ibm.ram.repository.web/
home.faces) or through a Web server (http://Webserver_Name/com.ibm.ram.repository.web/
home.faces).

Deploying Rational Asset Manager on Apache Tomcat V5.5 connected
to SQL Server 2005
Rational Asset Manager can be installed manually on an existing installation of Apache Tomcat. These
instructions are for deploying Rational Asset Manager on Tomcat V5.5.
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Before you begin

Tomcat server must be installed and running.
1. Locate the Rational Asset Manager Server WAR files. The installer places these files in Rational Asset

Manager install root/tomcat.
2. Start the Tomcat Manager: open http://localhost:8080/manager/html.
3. Configure Tomcat server to access SQL Server.

a. Open the file TOMCAT_INSTALL_PATH\conf\server.xml in a text editor.
b. Locate any lines in server.xml that begin with <Connector and contain port="8080"

orport="8009". Change the start of this line to <Connector URIEncoding="UTF-8".
c. Between the opening and closing tags for Global JNDI resources <GlobalNamingResources> and

</GlobalNamingResources> in server.xml, enter the text below for your version Tomcat.

Note: For the values your_username and your_password, use a userid and password that has
access to the database. The values shown for ″maxWait,″ “maxActive″ and ″maxIdle″ are sample
values and can be adjusted according to your performance needs.

Type:
<Resource name="jdbc/RAM_Con"
type="javax.sql.DataSource"
driverClassName="com.microsoft.jdbc.sqlserver.SQLServerDriver"
username="your_username"
password="your_password"
url="jdbc:microsoft:sqlserver://fully_qualified_server_name:SQLServer_port_number:db_name"
poolPreparedStatements="true"
maxWait="5000"
maxActive="4"
maxIdle="2"/>

4. Configure Tomcat server for security.
a. Edit Tomcat_install_path\conf\tomcat-users.xml.
b. Add user userIDs that are required for authentication.

5. Add the following JAR file to the Tomcat_install_path\common\lib folder:
v sqljdbc.jar

This file should be available from your database application provider.
6. Restart Tomcat.
7. Install the Rational Asset Manager WAR files on Tomcat server:

a. Open Tomcat Manager (http://localhost:8080/manager/html) and log with the correct userID
and password for administrator.

b. In the Select WAR file to upload field at the bottom of the Tomcat Web Application Manager
page under WAR file to deploy, browse to the location where you retrieved the file
com.ibm.ram.repository.web.tomcat_runtime.war from the installation media. Refer to “Retrieving
the Rational Asset Manager server application for Windows, Linux, or AIX from the installation
media with Installation Manager” on page 46 or “Retrieving the Rational Asset Manager server
application from the installation media for Linux for zSeries” on page 49 to locate this file.

c. Click Deploy.
d. Repeat the previous steps to deploy the com.ibm.ram.repository.web.ws.tomcat_runtime.war file,

entering this file as the WAR file to upload.
e. The WAR files are displayed in the list of applications

8. Install the Rational Asset Manager help WAR file on Tomcat server:
a. In Tomcat Manager in the section Deploy directory or WAR file located on server, enter the

location where you retrieved the file iehs.war from the installation media in the field WAR or
Directory URL. Refer to “Retrieving the Rational Asset Manager server application for Windows,

Manually installing and configuring Rational Asset Manager on an existing application server 61



Linux, or AIX from the installation media with Installation Manager” on page 46 or “Retrieving
the Rational Asset Manager server application from the installation media for Linux for zSeries”
on page 49 to locate this file.

b. Type /help in the Context Path (optional) field.
c. Click Deploy.
d. The WAR file is displayed in the list of applications

9. Install the Rational Asset Manager Asset-based Process Governance documentation WAR files on
Tomcat server:
a. In Tomcat Manager in the section Deploy directory or WAR file located on server, enter the

location where you retrieved the file rmcabdgovernprocess.war from the installation media in the
field WAR or Directory URL. Refer to “Retrieving the Rational Asset Manager server application
for Windows, Linux, or AIX from the installation media with Installation Manager” on page 46 or
“Retrieving the Rational Asset Manager server application from the installation media for Linux
for zSeries” on page 49 to locate this file.

b. Type /abdprocess in the Context Path (optional) field,
c. Click Deploy.
d. The WAR file is displayed in the list of applications

10. Open Rational Asset Manager using Tomcat (http://localhost:8080/com.ibm.ram.repository.web/
home.faces) or through a Web server (http://Webserver_Name/com.ibm.ram.repository.web/
home.faces).

Configuring the Rational Asset Manager server application
To finalize configuration of the Rational Asset Manager server application, perform the steps in this
section.

Before you begin

Note: Sample values in the section are for a basic standalone environment. For a more complex
installations, the server administrator will need to customize these settings for their environment.

The application server that hosts the Rational Asset Manager server application must be started before
you can complete the following steps:
1. Access the Rational Asset Manager server application using the appropriate URL:

v On embedded WebSphere Application Server:
http://host name:port number/com.ibm.ram.repository.web/home.faces

where port number (HTTP transport port, or WC_defaulthost) is 13080 by default.
For example, type:
http://localhost:13080/com.ibm.ram.repository.web/home.faces

To confirm the port number (WC_defaulthost) value, open the file installation location\ram\ewas\
profiles\profile1\properties\portdef.props in a text editor and check the value of wc_defaulthost,
where installation location is the installation location of Rational Asset Manager.

v On WebSphere Application server:
http://host name:port number/com.ibm.ram.repository.web/home.faces

where port number (HTTP transport port, or WC_defaulthost) is 9080 by default.
For example, type:
http://localhost:9080/com.ibm.ram.repository.web/home.faces

To confirm the WC_defaulthost value, open the WebSphere Application Server administrative
console and click Servers → Application Servers → server_name → Ports.
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v On Apache Tomcat:
http://host name:8080/com.ibm.ram.repository.web/home.faces

For example, type:
http://localhost:8080/com.ibm.ram.repository.web/home.faces

2. Log in using admin for both the User ID and Password.
3. The first time that you access Rational Asset Manager, you will see a Configuration Error page. Click

thehere link and enter the administrator user ID and password at the prompts. The Rational Asset
Manager Configuration page opens.

4. Specify the license server path:
a. Under License Server Path, type the port number, then the full name of the license server,

separated by ’@’. For example, 8010@license_server_path. If you have redundant license servers,
separate multiple entries with commas. (You must provide three servers.) For example,
27000@license_server_path_a.example.com, 27000@license_server_path_b.example.com,
27777@license_server_path_c.example.com.

5. Specify the Web server path:
a. Under Web Server Path, type:

http://host name:port number/com.ibm.ram.repository.web

where host name is the host name of the application server and port number is the HTTP transport
port. (If you are using a load balancer, specify the name of the load balancer. If you are using a
Web proxy server without a load balancer specify the name of the Web server.)
For example, type:
http://www.example.com:9080/com.ibm.ram.repository.web

6. Specify the Web Services path:
a. Under Web Services Path, type:

http://host name:port number/com.ibm.ram.repository.web.ws.was

where host name is the host name of the application server and port number is the HTTP transport
port. (If you are using a load balancer, specify the name of the load balancer. If you are using a
Web proxy server without a load balancer specify the name of the Web server.)
For example, type:
http://www.example.com:9080/com.ibm.ram.repository.web.ws.was

7. Specify the documentation path:
a. Under Path to Information center, if the help and documentation Web application is on the same

server as the server application, check Use default. Otherwise, clear the Use default check box
and type the URL to the server where the help Web application is installed; for example,
http://www.example.com:8080/help.

b. Under Path to Asset-based Development process, if the Asset-based Development and
Governance Process documentation Web application is on the same server as the server
application, check Use default. Otherwise, clear the Use default check box and type the URL to
the server where the help Web application is installed; for example, http://
www.example.com:8080/com.ibm.ram.repository.web/abdprocess.

8. Click on the Help link. (If the help system does not open, check that you included the
documentation when you installed Rational Asset Manager server.)

9. In the navigation pane, navigate to Configuring → Configuring the Rational Asset Manager
Repository → Post-installation configuration.

10. Complete the remaining topics in the section entitled ″Post-installation configuration.″ Additional
steps that may be needed, depending on your configuration, are included in the section entitled
″Optional configuration.″
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Additional configuration requirements for Linux and AIX

If you are running Rational Asset Manager on Linux or AIX, perform the tasks in this section as needed
to complete your configuration.

Enabling artifact content indexing for Linux and AIX
To enable artifact content indexing on Linux and AIX, you must add the Stellent files to your library path
environment variable LD_LIBRARY_PATH (for Linux) or LIBPATH (for AIX).

Before you begin

The Stellent files are located in the following directories, depending on which application you used for
installing Rational Asset Manager server:
v Embedded WebSphere Application Server V6.1: RAM_install_directory/ram/ewas/profiles/

appServerName/installedApps/node/RAM1WebApplication.ear/
com.ibm.ram.repository.web.ws.was.war/WEB-INF/classes/oiexport/

v WebSphere Application Server: appServer_install_directory/profiles/appServerName/installedApps/node/
RAM1WebApplication.ear/com.ibm.ram.repository.web.ws.was.war/WEB-INF/classes/oiexport/

v Apache Tomcat: appServer_install_directory/com.ibm.ram.repository.web.ws.tomcat_runtime.war/WEB-
INF/classes/oiexport/

About this task

If you do not modify your library path variable to enable content indexing, you typically see an error on
the Rational Asset Manager status page indicating that artifact indexing has been turned off.

To add update your library variable:
1. Consult your shell’s man page for specific details on how to set environment variables. For example,

in the Bash shell, enter the command LD_LIBRARY_PATH=$LD_LIBRARY_PATH:path for WebSphere
Application Server or Tomcat path shown above.

2. After you update the environment variable, restart the Rational Asset Manager server.

Enabling content indexing to run for non-root users (Linux and AIX)
If you must run WebSphere Application Server or Apache Tomcat as a non-root user, then set the
appropriate exporter permission on the directory that contains the files for Stellent content indexing.

About this task

To set exporter permission:
1. Log in as root.
2. In a command line, change to the directory of the Stellent content indexing files described in

“Enabling artifact content indexing for Linux and AIX.”
3. Type the following command: chmod 755 exporter.

Enabling database connectivity for non-root users (Linux and AIX)
If you must run WebSphere Application Server or Apache Tomcat as a non-root user, then you must set
the appropriate permission on the database Java archive files that you upload.
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About this task

To set permission:
1. Log in as root.
2. In a command line, change to the <WAS_install_directory>/profiles/<profile_name>/config/cells/

<cell_name>/ram_jdbc directory.
3. Type the following command: chmod 755 database jar file name (for example, chmod 755

db2jcc.jar).
4. Repeat step 3 for each database Java archive file that you uploaded.

66 IBM Rational Asset Manager, version 7.1.1.1 : Installation guide



Rational Asset Manager Tuning Guide

The performance of Rational Asset Manager heavily depends on how you tune your application server,
database, Web server, caching proxy, load balancer, and operating system. This section provides
guidelines for how to tune these systems and Rational Asset Manager. Although it is not possible to
cover every setting, the information provided here is a good starting point for driving high user loads on
Rational Asset Manager. This section does not cover hardware setups or the expected user loads that can
be supported in various setups. Refer to the Rational Asset Manager Capacity Planning Guide for this
information.

Rational Asset Manager Tuning

The Rational Asset Manager configuration page has settings that you can adjust to achieve optimal
performance. This page can be accessed by any repository administrator.

Table 4. Cross-Platform Rational Asset Manager Tuning Parameters

Problem Parameter / Setting Additional Details

Slow responses
when searching for
assets

Local and index folders / Do
not use a remote or shared
folder

For best performance, each application server should have its
own local and index folders on a hard disk local to the
machine. This should not be the same hard disk on which the
application server or operating system is installed.

To set the parameter, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration; in the Disk Storage section, set the Local
folder and Index folder parameters.

Slow responses
when searching for
assets.

Index folder / Use a fast
dedicated drive for the index
folder

It is important that the index folder resides on a dedicated
drive that is not used for other purposes. Separating the local
folder and index folder helps to ensure quick response times
when searching for assets.

To set the parameter, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration; in the Disk Storage section, set the Index
folder parameter.

General performance
issues at regular
intervals

Statistics index builder
schedule / 10 minutes

Frequently running the statistics index builder leads to poor
performance. A default setting of 10 minutes is adequate for
most environments.

To set the parameter, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration → Statistics index builder schedule.

General performance
issues at regular
intervals

Process subscriptions schedule
/ Set time for low workload
periods

Subscriptions can be processed at custom intervals. For better
performance, set this interval to a time when Rational Asset
Manager experiences a relatively low workload.

To set the parameter, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration → Statistics index builder schedule.
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Table 4. Cross-Platform Rational Asset Manager Tuning Parameters (continued)

Problem Parameter / Setting Additional Details

General performance
issues at regular
intervals

User and group information
update schedule / Set time
for low workload periods

User and group information can be processed at custom
intervals. For better performance, set this interval to a time
when Rational Asset Manager experiences a relatively low
workload.

To set the parameter, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration → User / group information update schedule.

General performance
issues at regular
intervals

Review process notifications
schedule / Set time for low
workload periods

Review process notifications can be processed at custom
intervals. For better performance, set this interval to a time
when Rational Asset Manager experiences a relatively low
workload.

To set the paramater, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration → Review process notification schedule.

Out of memory
errors in logs -
session issues

Maximum number of sessions
per user / 10

It’s possible for a single user to exhaust all available sessions
on a server. This may be the result of a poorly written script
or a denial of service attack. To prevent against this
possibility the default maximum sessions per user is set to 10.
After a user reaches this limit they will not be able to create
new sessions on the server.

To set the parameter, log in to Rational Asset Manager as an
administrator and navigate to Administration →
Configuration; in the Session Management section, set the
Maximum number of sessions per user parameter.

In addition to the above parameters, administrators can access the Job Status page in Rational Asset
Manager by navigating to Administration → Configuration → View Job Status. This page will display
currently running or previously run jobs that might impact performance in Rational Asset Manager. Error
messages might also display on the Job Status page.

Application Server Tuning

Rational Asset Manager works closely with your application server; therefore, optimizing your
application server settings will improve the performance of Rational Asset Manager.

This section specifically covers WebSphere Application Server V6.1 settings that significantly affect
performance. You can also adjust these setting in WebSphere Application Server V6.0, but the instructions
to set the parameters might be different.
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Important: Back up your WebSphere Application Server profile before changing any parameters.

Table 5. Cross-Platform WebSphere Application Server V6.1 Tuning Parameters

Problem
Parameter /
Setting Additional Details

Out of memory
errors in logs

Java Virtual
Machine heap size
/ Between 1300
and 2000

On a server with 4GB of memory is installed, you can specify two instances
with a heap size of 1300MB, or one instance with a heap size of 2000MB. You
must watch the system paging to make sure that there is enough memory
available. If your server has 8GB of memory, then specify 2 instances with a
heap size of 2000MB for each instance.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application servers → Java and process management →
Process definition → Java virtual machine → Initial heap size and Maximum
heap size.

Database
connection
errors

JDBC Maximum
Connections / 100

Make sure that there are enough JDBC connections available to support all
users that are logged into Rational Asset Manager.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Resources → JDBC → Data sources → <Rational Asset Manager
data source> → Connection pool properties → Maximum connections.

Refer also to topic ″MAXAPPLS and MAXAGENTS parameters″ under DB2
tuning.

Refer also to topic ″Maximum number of processes for AIX and Linux″ under
operating system tuning.

Out of memory
errors in logs -
session issues

Maximum
In-Memory Session
Count / 200

By default, WebSphere Application Server 6.1 maintains up to 1000 sessions in
memory. However, the Allow Overflow option is also selected, which
indicates that additional sessions will be stored in a secondary session table.
These default settings may allow for potential out of memory conditions. It is
best to limit the maximum number of in memory disabling the Allow
Overflow option and setting the maximum in memory session count to a
value that is appropriate for the server memory.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application Servers → <Server name> → Session
management → Maximum in-memory session count.

Out of memory
errors in logs -
session issues

Session Timeout /
Default (30
minutes)

The default value for a session timeout in WebSphere Application Server 6.1 is
30 minutes. Setting this value to a shorter time allows for more users,
especially if you have many users making quick transactions. Setting this
value too low might not allow users to upload very large assets. Remember
that most users do not explicitly log out when they are done with a
transaction: most sessions will exist until they timeout.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application servers → <Server name> → Session
management → Set timeout.

High CPU
usage observed

Performance
monitor
infrastructure /
disabled

By default, WebSphere Application Server v6.1 enables basic performance
monitor infrastructure (PMI). Although PMI is a good tool for tuning an
application server, for maximum performance, disable this feature after the
server has been properly tuned. You must disable it for all instances and node
agents.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Monitoring and Tuning → Performance Monitoring Infrastructure
(PMI) → <Server name> → Enable Performance Monitoring Infrastructure
(PMI).
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Table 5. Cross-Platform WebSphere Application Server V6.1 Tuning Parameters (continued)

Problem
Parameter /
Setting Additional Details

General
performance
issues

Prepared
Statement Cache /
100

WebSphere Application Server provides the ability cache commonly used
prepared statements. If cached statements are being discarded, turn on PMI in
WebSphere Application Server and increase the value.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Resources → JDBC → Data sources → <Rational Asset Manager
data source> → WebSphere Application Server data source properties →
Statement cache size.

Refer also to topic ″Further Information for Tuning WebSphere Application
Server.″

Session timeout
issues

Maximum
In-Memory Session
Count / Default

By default, Websphere Applcation Server 6.1 will maintain up to 1000 sessions
in memory. However, the Allow Overflow option is also selected, which
indicates that additional sessions will be stored in a secondary session table. If
you expect to have more than 1000 in memory sessions, you must increase the
number for the secondary session table.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application Servers → <Server name> → Session
Management → Maximum in-memory session count.

Periodic
slowness;
observed
performance
spikes due to
garbage
collections

Class Garbage
Collection /
Xgcpolicy:optavgpause
(for WebSphere
Application Server
Fix Pack 16 and
below) or
-Xgcpolicy:gencon
(for WebSphere
Application Server
Fix Pack 17 and
above)

Your specific server environment or workload might benefit from one of the
other garbage collection settings. See http://java.sun.com/docs/hotspot/
gc5.0/gc_tuning_5.html for more information on garbage collection settings.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application servers → <Server name> → Java and
process management → Process definition → Java virtual machine → Generic
JVM arguments.
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Table 5. Cross-Platform WebSphere Application Server V6.1 Tuning Parameters (continued)

Problem
Parameter /
Setting Additional Details

Server fails
during transfer
of large files;
possibly with
out of memory
or malloc
errors in logs

Web container
custom property
channelwritetype /
synchronous data
transfer (sync)

The use of asynchronous data transfer may require an excessive number of
buffers to send data over a TCP/IP connection.

1. In the WebSphere Administrative Console, navigate to Servers →
Application Servers → serverName → Web Container Settings → Web
Container → Custom Properties.

2. Click New.

3. Add the following pair:

v Name: com.ibm.ws.webcontainer.channelwritetype

v Value: sync

Click OK and then save the configuration. Restart the application server to
pick up the property.

For a deployment manager:

1. Start an interactive wsadmin session:

<dmgr-profile-root>\bin>wsadmin -lang jacl

2. Copy the following block of lines, then paste them all at once at the
wsadmin> prompt:

set dmgr [$AdminConfig getid /Server:dmgr/]
set webcontainer [$AdminConfig list WebContainer $dmgr]
$AdminConfig create Property $webcontainer {{name com.ibm.ws.webcontainer.channelwritetype} {value sync}} properties
$AdminConfig show $webcontainer
$AdminConfig save

3. Restart the deployment manager to pick up the property.

For more information, refer to http://www.ibm.com/support/
docview.wss?uid=swg21317658.

Table 6. AIX / Linux WebSphere Application Server V6.1 Tuning Parameters

Problem
Parameter /
Setting Additional Details

CPU is being
overused or
underused

WebContainer
Pools / 30

Web container threads are used by the application server to handle requests. If
you notice that the CPU of the server is underused, try increasing this
number. If it is overused, try reducing this number. Do not set the web
container threads above 50.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application servers → <Server name> → Thread pools →
WebContainer.

Minimum size: 15

Maximum size: 30
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Table 7. Windows WebSphere Application Server 6.1 Tuning Parameters

Problem
Parameter /
Setting Additional Details

CPU is being
overused or
underused

WebContainer
Pools / 50

Web container threads are used by the application server to handle requests. If
you notice that the CPU of the server is underused, try increasing this number.
If it is overused, try reducing this number. Do not set the web container
threads above 50.

To set the parameter, log in to WebSphere Administrative Console and
navigate to Servers → Application servers → <Server name> → Thread pools →
WebContainer.

Minimum size: 25

Maximum size: 50

In addition to these parameters, you can tune WebSphere Application Server under a specific workload
by turning on Performance Monitor Infrastructure (PMI). This will provide detailed graphs showing
performance data. Although you should have PMI turned on under a normal workload to capture data,
this will decrease performance and it should be turned off after data capture is complete.

To enable PMI, log in to WebSphere Administrative Console and navigate to Monitoring and Tuning →
Performance Monitoring Infrastructure (PMI) → <Server name> → Enable Performance Monitoring
Infrastructure (PMI).

Additional resources:
v http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/

com.ibm.websphere.base.doc/info/aes/ae/tprf_tuneprf.html

Database Server Tuning

A well tuned database is extremely important to achieving a high level of performance in Rational Asset
Manager.

Note: This section is specific to DB2 version 9.5, but many of the parameters here are available in other
versions of DB2. There might be similar parameters in Oracle and SQL Server.

Table 8. Cross-Platform DB2, version 9.5 Tuning Parameters

Problem Parameter / Setting Additional Details

No
connections
available

MAXAPPLS /
AUTOMATIC
(WebSphere
Application Server
maximum JDBC
connections * the
number of
instances)

Make sure that MAXAPPLS is set high enough to handle the number of JDBC
Connection Pools that are specified in your application server. The
MAXAPPLS setting must be greater than or equal to the JDBC Maximum
Connections setting.

Setting location: Database parameters

Also refer to topic ″JDBC Maximum Connections″ under Application Server
Tuning

No
connections
available

MAXAGENTS /
AUTOMATIC
(WebSphere
Application Server
maximum JDBC
connections * the
number of
instances)

Make sure that MAXAGENTS is set high enough to handle the number of
JDBC Connection Pools that are specified in your application server. The
MAXAGENTS setting must be greater than or equal to the JDBC Maximum
Connections setting.

Setting location: Instance parameters

Also refer to topic ″JDBC Maximum Connections″ under Application Server
Tuning
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Table 8. Cross-Platform DB2, version 9.5 Tuning Parameters (continued)

Problem Parameter / Setting Additional Details

Deadlocks MAXLOCKS /
AUTOMACTIC (80)

The MAXLOCKS parameter indicates the maximum percentage of available
locks within DB2 that an application can hold before escalating row locks to
table locks. These table locks can result in deadlocks.

Setting location: Database parameters

Deadlocks LOCKLIST /
AUTOMATIC
(20000)

The LOCKLIST parameter represents the available memory for locks in DB2.
You can use the following formula to set this parameter in a specific
environment:

LOCKLIST = [(512 * 64 * MAXAPPLS) / 4096]*2

Do not set this higher than the memory heap that is available to DB2. Setting
location: Database parameters

Deadlocks LOCKTIMEOUT /
60

If a single lock is stopping other transactions, this can result in a deadlock. To
make sure this does not happen, set the lock time out to 60 seconds.

Setting Location: Database parameters

General
performance
issues

Statistics / Schedule
regular runs

Running statistics against the tables will help the optimizer determine the best
path for accessing data. Statistics should be run on a regular basis or
scheduled automatically.

Errors during
database
migrations

LOG_FIL_SIZ /
10000

The migration function in Rational Asset Manager might not work on
databases with thousands of assets of the LOG_FIL_SIZ is set too low.

Table 9. AIX / Linux DB2, version 9.5 Tuning Parameters

Problem Parameter / Setting Additional Details

Unable to
access DB2
server

*See Topic:
Maximum number
of processes for AIX
and Linux under
operating system
tuning.

If you cannot access the DB2 server, it might be possible that the db2agents
have used the maximum number of processes.

Other parameters to check in your specific environment can include, but is not limited to:
v APP_CTLHEAP_SZ
v DATABASE_MEMORY
v DFT_PREFETCH_SZ
v NUM_IOCLEANERS
v NUM_IOSERVERS
v SORTHEAP
v MAX_QUERYDEGREE

Setting parameters to AUTOMATIC within DB2 will allow DB2 to tune the parameters based on the
current workload. At first, this can result in a negative performance impact and some potential errors if
certain values are not tuned quickly enough, but it is a good way to determine what parameters may
need to be tuned to achieve maximum performance.

If you set a parameter too high and cannot start the DB2 control center, the parameter can be changed on
the DB2 command line by using the statement db2 update db cfg for db_name using parameter_name
value.
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Additional Resources:
v DB2 is a complex system with many tuning parameters that have not been covered in this very brief

overview. One of the most comprehensive articles for tuning DB2 is “Best Practices for Tuning DB2
UDB V8.1 and its Databases” by Fraser McArthur. http://www.ibm.com/developerworks/db2/
library/techarticle/dm-0404mcarthur/

Web Server Tuning

This section provides tuning information for IBM HTTP Web Server, which is included in the
supplements for Websphere Application Server.

The parameters that are described in this section can be modified in the httpd.conf file.

Table 10. Cross-Platform Web Server Tuning Parameters

Problem Parameter / Setting Additional Details

Connection
closed errors

MaxKeepAliveRequests
/ 0

This directive signifies the maximum number of requests that a single client
can make before the connection is closed. Generally, this value is set to 0.

General
performance
issues

LoadModule /
ibm_afpa_module
modules/
mod_afpa_cache.so

To cache static content such as images, uncomment the following
line:LoadModule ibm_afpa_module modules/mod_afpa_cache.so

This will activate the Fast Response Cache Accelerator (FRCA).

General
Performance
Issues

Afpa Logging / off If you do not need FRCA logging turned on, you can turn it off by placing
the comment character (‘#’) before the AfpaLogFile directive. Doing this will
also boost server performance.#AfpaLogFile ″_path_to_server_/logs/
afpalog″ V-ECLF

Table 11. AIX / Linux Web Server Tuning Parameters

Problem Parameter / Setting Additional Details

Out of
threads errors
in web server
logs

ThreadLimit / 25 Depending on how many users access Rational Asset Manager at a given
time, it might be necessary to increase the thread limit. To see if you need to
increase the limit, check the web server logs for out of threads errors or
warnings.

Out of
threads errors
in web server
logs

ThreadsPerChild /
25

Depending on how many users access Rational Asset Manager at a given
time, it might be necessary to increase the thread limit. To see if you need to
increase the limit, check the web server logs for out of threads errors or
warnings.

Table 12. Windows Web Server Tuning Parameters

Problem Parameter / Setting Additional Details

Out of
threads
errors in web
server logs

ThreadLimit / 4000 Depending on how many users access Rational Asset Manager at a given time,
it might be necessary to increase the thread limit. To see if you need to
increase the limit, check the web server logs for out of threads errors or
warnings.

Out of
threads
errors in web
server logs

ThreadsPerChild /
3000

Depending on how many users access Rational Asset Manager at a given time,
it might be necessary to increase the thread limit. To see if you need to
increase the limit, check the web server logs for out of threads errors or
warnings.

Additional Resources:
v http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/

com.ibm.websphere.ihs.doc/info/ihs/ihs/tihs_startadmserv.html
v http://httpd.apache.org/
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Caching Proxy Tuning

This section specifically covers IBM Edge Caching Proxy.

You can modify the parameters that are described in this document in the ibmproxy.conf file.

Table 13. IBM Edge Server Tuning Parameters

Problem Parameter / Setting Additional Details

Unable to
upload assets
with large
file sizes

LimitRequestBody /
2G

By default, this parameter is set to 10 M. Change this to a larger value so that
users can upload large files.

Unable to
upload assets
with large
file sizes due
to timeouts

InputTimeOut / 60
Minutes

Changing this parameter to 60 minutes will give users sufficient time to
upload large assets.

Refer also to topic ″Session Timeout″ under Application Server Tuning

Unable to
upload assets
with large
file sizes due
to timeouts

ReadTimeout / 60
Minutes

Changing this parameter to 60 minutes will give users sufficient time to
upload large assets.

Refer also to topic ″Session Timeout″ under Application Server Tuning

Unable to
upload assets
with large
file sizes due
to timeouts

ScriptTimeout / 60
Minutes

Changing this parameter to 60 minutes will give users sufficient time to
upload large assets.

Refer also to topic ″Session Timeout″ under Application Server Tuning

Table 14. Additional Settings

Parameter Setting

SendRevProxyName yes

PurgeAge 3

DirShowCase off

MaxActiveThreads 110

ConnThreads 15

MaxPersistRequest 15

ServerConnPool on

CacheMemory 1200 M (max)

CacheAlgorithm responsetime

numclient 100

flexibleSocks off

listenBacklog 256

Operating System Tuning

Cross-Platform:
v Make sure that the page file size is at least 2GB.
v On AIX systems, define the paging file on a disk that is separate from the disk where WebSphere

resides.
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Windows:

Table 15. Windows Operating System Settings

Problem Parameter / Setting Additional Details

“Address
already in
use” errors
seen when
testing with
Rational
Performance
Tester.

registry item
MaxUserPort /
65534

1. In the registry editor, navigate to My Computer\HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Services\Tcpip\Parameters.

2. Right-click Parameters, click New → DWORD Value.

3. Type MaxUserPort for the name of the DWORD value.

4. Right-click the value and click Modify.

5. Set the value to 65534.

6. Under base, select Decimal.

7. Reboot the machine.

To avoid
session
availability
bottleneck
(seen with 900
users on
6-instance
cluster)

registry item
TcpTimedWaitDelay
/ 30

1. In the registry editor, navigate to My Computer\HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Services\Tcpip\Parameters.

2. Right-click Parameters, click New → DWORD Value.

3. Type TcpTimedWaitDelay for the name of the DWORD value.

4. Right-click the value and click Modify.

5. Set the value to 30.

6. Under Base, select Decimal.

7. Reboot the machine.

Additional Resources:
v http://www.redbooks.ibm.com/abstracts/redp3943.html?Open

AIX/Linux

The following instructions are specific to AIX.

Maximum number of processes

The maximum number of processes that a user can run must be set to a high enough level. This is
especially true of the database server, which can have many database agents.

To view the set maximum number of processes, use the following command:
lsattr -E -l sys0 -a maxuproc

To set the maximum number of processes, use the following command:
chdev -l sys0 -a maxuproc=2000

This will result in a limit of 2000.

File descriptors

In the /etc/security/limits file, change all settings to unlimited.
Soft FILE Size -1
Soft CPU Time -1
Soft STACK Size -1
Soft CORE File Size -1
Hard FILE Size -1
Hard CPU Time -1
Hard STACK Size -1
Hard CORE File Size -1
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This can also be accomplished by using the ulimit command.

Table 16. AIX/Linux Operating System Settings

Problem Parameter / Setting Additional Details

Going to
external
DNS

/etc/netsvc.conf Add this line to the netsvc.conf file:

hosts=local,bind4

Ethernet
adapter is
doing
Segmentation
Offload

no -o tcp_recvspace=65536
no -o tcp_sendspace=65536
no -o udp_sendspace=65536
no -o udp_recvspace=65536
no -o tcp_finwait2=60
no -o tcp_timewait=1
no -o tcp_keepidle=600
no -o tcp_keepintvl=10
no -o tcp_keepinit=40

The impact of these commands is affected by how big the TCP/IP
packets are that your application creates, sends, or receives. The
″no -a″ commands are in effect until the system is rebooted. To
make them permanent, add them to the /etc/tunables/nextboot
file. These can also be set on a per-tcpip-interface basis. Check the
″lsattr -E -l en0″ and if they are not set there, then AIX uses the
″no -a″ values.

AIX sees a
number of
virtual
processors
that is
greater than
the number
of physical
processors.

smtctl -m off The AIX smtctl command shows how many virtual processors
that AIX sees. Turn SMT off with the command:

smtctl -m off

The two threads on each physical processor share a Level1 cache.
If the threads are unrelated, they corrupt the other cache data,
which can end up slowing down the overall throughput as the
system waits for more memory fetches to refresh the cache.
Consider making a couple of test runs with this on and off to see
what setting is best for your workload.

NIS is
running.

Disable NIS. If the /etc/hosts and /etc/passwd files contain lines with ’+’, then
the system is running ’NIS’, also called YellowPages. This can also
be seen by

ps -ef | grep yp

NIS is not normally enabled on AIX-out-of-the-box. If you do not
need this for the application server, consider a test run with NIS
disabled.

Many
sockets in
FIN_WAIT_2
state

no -o tcp_finwait2=60 If the ″netstat -an″ shows many sockets in FIN_WAIT_2 state, this
means “high connection rates occur” and will correspond to the
“Address already in use” message that is in server logs.

This can be controlled by a ″no″ command. First look at the
current setting,

"no -a | grep fin"

and see the default of 1200 half-seconds (i.e., 10 minutes). Try a
test run with the following setting:

no -o tcp_finwait2=60

The ″no″ command is good until reset or until a reboot. To make it
permanent, define it in /etc/tunables/nextboot.

The
processor is
capable of
using large
pages, but is
not doing
so.

Add parameter to JVM:
-Xlp/-Xlp64

Enables 64 KB pages.

Additional Resources:
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v http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/
com.ibm.websphere.base.doc/info/aes/ae/tprf_tuneprf.html

v http://www.redbooks.ibm.com/redbooks/pdfs/sg246392.pdf
v http://publib.boulder.ibm.com/infocenter/wasinfo/v4r0/index.jsp?topic=/com.ibm.websphere.v4.doc/

wasa_content/0901.html
v ftp://ftp.software.ibm.com/software/webserver/appserv/library/v61/wasv610nd_tune.pdf
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Creating a backup of a Rational Asset Manager repository

To make a backup copy of your Rational Asset Manager repository that can be restored later:
1. Log into the Rational Asset Manager Web client as an administrator.
2. Navigate to Administration → Configuration.
3. Note the location of the persist folder.
4. Stop the server.
5. On the machine where the database is located, create a backup of the Rational Asset Manager

database. Refer to the documentation for your database application for instructions.
6. In the operating system, create a backup copy of the persist folder
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Installing the Rational Asset Manager Eclipse Client

This section describes how to install the Rational Asset Manager Eclipse client application.

About this task

You can install the Rational Asset Manager Eclipse Client by the following methods:
v If you have an existing Eclipse integrated development environment (IDE) installed on your computer,

then you can use Eclipse update manager to find and install the Rational Asset Manager Eclipse client
plug-ins from a Rational Asset Manager server. To install the client plug-in, follow the Eclipse update
process (Help → Software Updates → Find and Install).

v If you do not have an existing Eclipse IDE, then you can install the Eclipse client from the Rational
Asset Manager installation media. Note that you can also install the Eclipse client into an existing
Eclipse IDE by this method.

Installing Rational Asset Manager Eclipse client using Eclipse update
manager
You can install the Rational Asset Manager Eclipse client into an existing version of Eclipse by using the
Eclipse update manager.

Before you begin

Your Eclipse IDE must meet the software requirements before you can install the Rational Asset Manager
Eclipse client into it. See “Software requirements” on page 14 for detailed requirements. You must also
know the URL for accessing the Rational Asset Manager server using the Web client.
1. Start Eclipse.
2. Click Help → Software Updates → Find and Install.
3. In the Install/Update pane, select Search for new features to install.
4. Click New Remote Site

5. Provide the Update site details:
a. Type a name for the new entry; for example, type Rational Asset Manager.
b. Open the Rational Asset Manager Web client and click Extensions in the header or footer of the

application.
c. On the Extensions page in the Eclipse Client Plug-in section, copy the URL listed next to Update

site and paste it into the URL field.
If the Rational Asset Manager server is only available on an https protocol, the Eclipse client will
not be able to use the update site. To resolve this, refer to the topic entitled Adding the server’s
public certificate to the Eclipse client.

6. Click OK.
7. Select the new Rational Asset Manager site.
8. Accept the license agreement and click Next.
9. Click Finish.

10. Click Install All.

Note: If you are installing the Rational Asset Manager Eclipse client into Rational Team Concert, you
can uncheck these features, which should already be installed:
v IBM Rational common user assistance
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v IBM Rational common user assistance resources

Results

To verify that the installation was successful, open the Asset Management perspective; click Window →
Open Perspective → Other and then select Asset Management from the list. Click OK.

Installing IBM Rational Asset Manager Eclipse client using the IBM
Installation Manager graphical interface
The following steps describe how to install the Rational Asset Manager Eclipse client package with the
Installation Manager GUI.
1. Start the Rational Asset Manager launchpad program (see “Installing from the launchpad program”

on page 25) and then select IBM Rational Asset Manager. If Installation Manager is not already
installed, follow the steps in the installation wizard to complete the installation. The Install Packages
wizard opens.

2. The Install page of Install Packages wizard lists all the packages found in the repositories that
Installation Manager searched.

3. To search for updates to the IBM Rational Asset Manager package, click Check for updates.
4. Select the Rational Asset Manager client and any updates to the package that you want to install.

Updates that have dependencies are automatically selected and cleared together. Click Next to
continue.

Note: If you install multiple packages at the same time, then all the packages will be installed into
the same package group.

5. On the Licenses page, read the license agreement for the selected package. If you selected more than
one package to install, there might be a license agreement for each package. On the left side of the
License page, click each package version to display its license agreement. The package versions that
you selected to install (for example, the base package and an update) are listed under the package
name.
a. If you agree to the terms of all of the license agreements, click I accept the terms of the license

agreements.
b. Click Next to continue.

6. If you are installing the first package on this computer, then on the Location page, type the path for
the shared resources directory in the Shared Resources Directory field; or accept the default path. The
shared resources directory contains resources that can be shared by one or more package groups.
Click Next to continue.
The default path is:
v For Windows: C:\Program Files\IBM\SDP70Shared
v For Linux: /opt/IBM/SDP70Shared

Important: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this to help ensure adequate space for the shared resources of
future packages. You cannot change the directory location unless you uninstall all packages.

7. On the Location page, either choose an existing package group to install the IBM Rational Asset
Manager Eclipse client package into, or create a new one. A package group represents a directory in
which packages share resources with other packages in the same group. To create a new package
group:
a. Click Create a new package group.
b. Type the path for the installation directory for the package group. The name for the package

group is created automatically.
The default path is:
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v For Windows: C:\Program Files\IBM\SDP70
v For Linux: /opt/IBM/SDP70

c. Click Next to continue.
8. On the next Location page, you can choose to extend an existing Eclipse IDE already installed on

your system, adding the functionality in the packages that you are installing.
v If you do not want to extend an existing Eclipse IDE, click Next to continue.
v To extend an existing Eclipse IDE:

a. Select Extend an existing Eclipse.
b. In the Eclipse IDE field, type or navigate to the location of the folder containing the eclipse

executable file (eclipse.exe or eclipse.bin). Installation Manager will check if the Eclipse IDE
version is valid for the package that you are installing. The Eclipse IDE JVM field displays the
Java Virtual Machine (JVM) for the IDE that you specified.

c. Click Next to continue.
9. On the Features page under Languages, select the languages for the package group. The

corresponding national language translations for the user interface and documentation for the IBM
Rational Asset Manager package will be installed. Note that your choices apply to all packages
installed under this package group.

10. On the next Features page, click Next. Note that the one feature for IBM Rational Asset Manager
cannot be cleared.

11. On the Summary page, review your choices before installing the IBM Rational Asset Manager
package. If you want to change the choices that you made on previous pages, click Back and make
your changes. When you are satisfied with your installation choices, click Install to install the
package. A progress indicator shows the percentage of the installation completed.

12. When the installation process is complete, a message confirms the success of the process.
a. Click View log file to open the installation log file for the current session in a new window. You

must close the Installation Log window to continue.
b. In the Install Package wizard, select whether you want IBM Rational Asset Manager client to

start when you exit.
c. Click Finish to launch the selected package. The Install Package wizard closes and you are

returned to the Start page of Installation Manager.

Installing silently
About this task

You can install a product package by running Installation Manager in silent installation mode. When you
run Installation Manager in silent mode, the user interface is not available; instead, Installation Manager
uses a response file to input the commands that are required to install the product package.

Running Installation Manager in silent mode is helpful because it enables you to use a batch process to
install, update, modify and uninstall product packages through scripts.

Note: For Rational Asset Manager, only the Eclipse client can be installed silently.

Note that you must install Installation Manager before you can silently install a package.

There are two main tasks required for silent installation:
1. Create the response file.
2. Run Installation Manager in silent installation mode.
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What to do next

For details on creating a response file and running Installation Manager in silent mode, see the
Installation Manager online help.

Adding the server public certificate to the Eclipse client
If the Rational Asset Manager server is only available on an https protocol, the Eclipse client will not be
able to use the update site. To resolve this, you must add the server’s public certificate to the Eclipse
client.

About this task

These instructions are for a Windows computer with a Firefox browser. Instructions for Linux are similar.
1. Save the certificate.

a. Access the Rational Asset Manager Web client using a browser.
b. Double-click the security icon in the status bar. The Security window opens.
c. Click View Certificate.
d. In the Certificate Viewer, click the Details tab.
e. On the Details page, click Export.
f. In the Save Certificate to File window, select X.509 Certificate (DER) in the Save as Type list.
g. Click Save.

2. (Optional) Create the keystore. You can use an existing keystore or create a new one. To create a new
keystore, run the following command from a command prompt:
keytool.exe -genkey -keystore ram.keystore -storepass ibmram

The keystore will contain the keys for the Eclipse client.
3. Import the certificate to the keystore.

a. From a command prompt, run the following command to import the certificate:
keytool.exe -import -alias [server] -file [server].der -keystore ram.keystore -storepass ibmram

Where server is the name of the server with Rational Asset Manager server.
b. Type yes to accept the certificate and press Enter.
c. Verify that the certificate was added to the keystore.

4. Launch the Eclipse client from a command prompt using the following command:
eclipse -vmargs -Djavax.net.ssl.trustStore="drive:\path\to\certificate\ram.keystore" -Djavax.net.ssl.trustStorePassword=ibmram

Where drive:\path\to\certificate\ram.keystore is the full path to the ram.keystore file. Eclipse will
start and will trust the connection with the server.
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Uninstalling Rational Asset Manager

The Uninstall Packages option in the Installation Manager enables you to uninstall packages from a single
installation location. You can also uninstall all the installed packages from every installation location.

Before you begin

To uninstall the packages, you must log in to the system using the same user account that you used to
install the product packages.

Note: If you are uninstalling Rational Asset Manager server, Installation Manager will only remove the
files that it installed. If you installed the Rational Asset Manager server manually on an application
server, then you must uninstall it manually.

Note: If you deployed enterprise or Web archive files using the Rational Asset Manager server setup
application, you must uninstall them manually or through the server setup application. Installation
Manager can only uninstall applications that it has installed.

About this task

To uninstall the packages:
1. Close the programs that you installed using Installation Manager.
2. If you are uninstalling Rational Asset Manager server on embedded WebSphere Application server,

then stop the server. For example, run the stopServer.bat server1 from a command prompt in the
WAS_PROFILE/bin folder.

3. On the Start page click Uninstall Packages.
4. In the Uninstall Packages page, select the Rational Asset Manager product package that you want to

uninstall. Click Next.
5. In the Summary page, review the list of packages that will be uninstalled and then click Uninstall.

The Complete page is displayed after the packages are removed.
6. Click Finish to exit the wizard.
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Uninstalling Rational Asset Manager applications installed
using the server setup application

If you used the Rational Asset Manager server setup application to deploy Rational Asset Manager
applications, instead of using the Installation Manager to install them, you can uninstall the enterprise
and Web archives from the application server using the server setup application, but you must manually
remove any other settings and configurations.
1. Launch the Rational Asset Manager server setup application.
2. On the deployment page, click uninstall for each enterprise or Web archive to be removed from the

application server.
3. Open the WebSphere Administrative Console and remove changes made for Rational Asset Manager.

Refer to the section entitled “Installing Rational Asset Manager server manually on WebSphere
Application Server” on page 50 for assistance identifying configurations that were set up for Rational
Asset Manager.
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Uninstalling Rational Asset Manager from WebSphere
Application Server manually

If you want to uninstall Rational Asset Manager manually, use the following instructions to uninstall the
enterprise and Web archives from the application server and remove any other settings and
configurations.
1. Start the WebSphere Administrative Console.
2. Log in using an administrator user ID and password.
3. Delete the datasource.

a. Locate and click the Datasource with the JNDI name jdbc/RAM_Con
v If you are using a standalone server, you may find it under the Server scope.
v If you are using a network server, you may find it under the cluster that Rational Asset

Manager was installed on.
b. Note the name of the component-managed authentication alias that the datasource uses.
c. Delete the datasource.
d. Navigate to Security → Secure administration, applications & Infrastructure → Java

Authentication and Authorization Service → J2C Authentication Data.
e. Delete the entry whose name matches the component-managed authentication alias that you

noted.
4. Optionally, if your server is a network deployment, delete system integration bus.

a. Navigate to Service Integration → Buses.
b. Delete the bus named RAMBus.
c. Navigate to Resources → JMS → Connection Factories.
d. Delete the factory named RAM Factory. It might be under the scope of the cluster that Rational

Asset Manager was installed on.
e. Navigate to Resources → JMS → Topics.
f. Delete the topic named RAM Cache. It might be located under the scope of the cluster that

Rational Asset Manager was installed on.
5. Remove the applications.

a. Click Applications → Enterprise Applications in the navigation pane.
b. Check any of the applications that are installed:

v RAM1WebApplication
v com.ibm.ram.repository.setup.web.ear
v iehs_war
v rmcabdgovernprocess_war

c. Click Uninstall.
d. Click Save to apply the changes to the master configuration.

6. Optionally, if Rational Asset Manager was the only application on the server, remove any
environment variables.
a. Click Environment → WebSphere Variables in the navigation pane.
b. Click the name of any environment variables that were set up for Rational Asset Manager (for

example, Oracle_JDBC_DRIVER_PATH).
c. Click Delete.
d. Click Save to apply the changes to the master configuration.
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7. Optionally, reconfigure authentication and security settings. If you configured security specifically for
Rational Asset Manager, then revert any settings to the previous configuration. If the security settings
apply to other applications, do not modify them.

8. Restart the server.
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Working with IBM Installation Manager

About this task

This section deals with some common tasks relating to IBM Installation Manager. For more information,
see the Installation Manager online help or the Installation Manager Information Center at
http://publib.boulder.ibm.com/infocenter/install/v1m0r0/index.jsp.

Installing Installation Manager on Windows
About this task

If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is started automatically if it is not already installed on your workstation. (For more
information on this process, refer to “Installing from the launchpad program” on page 25.) In other cases,
you must manually start the installation of Installation Manager.

To start the installation of Installation Manager manually:
1. Run install.exe from the InstallerImage_win32 folder on the first installation disk.
2. Click Next on the Install Packages page.
3. Review the license agreement on the License Agreement page and select I accept the terms in the

license agreement to accept. Click Next.
4. Click the Browse button on the Destination Folder page to change the installation location if required.

Click Next.
5. Click Install on the Summary page. When the installation process is complete, a message confirms the

success of the process.
6. Click Finish. IBM Installation Manager opens.

Installing Installation Manager on Linux and AIX
About this task

IBM Installation Manager is installed by the launchpad. For more information on this process, refer to
“Installing from the launchpad program” on page 25.

To install Installation Manager manually:
1. Open a terminal window with root user privileges.
2. Run install.

v 2000Linux This file is located in the InstallerImager_linux folder on the first installation disk.

v This file is located in the InstallerImager_aix folder on the first installation disk.
3. Click Next on the Install Packages screen.
4. Review the license agreement on the License Agreement page and select I accept the terms in the

license agreement to accept. Click Next.
5. If necessary, edit the installation directory location. Click Next.
6. Click Install on the information summary page. When the installation process is complete, a message

confirms the success of the process.
7. Click Finish. IBM Installation Manager opens.
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Starting Installation Manager on Windows
About this task

IBM Installation Manager should be started from the launchpad program. Doing so starts Installation
Manager with a configured repository preference and selected Rational Asset Manager packages. If you
start Installation Manager directly, then you must set a repository preference and choose product
packages manually. For more information, see “Planning your installation” on page 3.

To start Installation Manager manually:
1. Open the Start menu from the Taskbar.
2. Select All Programs → IBM Installation Manager → IBM Installation Manager.

What to do next

Starting Installation Manager on Linux and AIX
About this task

IBM Installation Manager should be started from the launchpad program. Doing so starts the Installation
Manager with a configured repository preference and selected Rational Asset Manager packages. If you
start Installation Manager directly, then you must set repository preference and choose product packages
manually. For more information, see “Planning your installation” on page 3.

To start Installation Manager manually:
1. Open a terminal window with root user privileges.
2. Change directory to the installation directory for Installation Manager (by default,

/opt/IBM/InstallationManager/eclipse) and run IBMIM.

Uninstalling Installation Manager on Windows
About this task

To uninstall Installation Manager:
1. Open the Start menu from the Taskbar.
2. Select All Programs → IBM Installation Manager → Uninstall IBM Installation Manager.
3. Click Next on the Uninstall page. The IBM Installation Manager is selected for uninstallation.
4. Click Uninstall in the Summary page.

Results

Note: You can also uninstall Installation Manager by using the Control Panel. Click Start → Settings →
Control Panel, and then double-click Add or Remove Programs. Select the entry for IBM Installation
Manager and click Remove.

Uninstalling Installation Manager on Linux and AIX
About this task

IBM Installation Manager must be uninstalled using the package management tool that is included with
your Linux or AIX version.

To uninstall Installation Manager manually on Linux or AIX:
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1. Open a terminal window with root user privileges.
2. Change directory to the uninstallation directory of Installation Manager. By default, this is

/var/ibm/InstallationManager/uninstall. If IBM Installation Manager has been installed to a location
other than the default path, locate the uninstall directory relative to where Installation Manager is
installed.

3. Run ./uninstall.

Silently installing and uninstalling Installation Manager
IBM Installation Manager can be silently installed and uninstalled.

Silently installing Installation Manager on Windows
About this task

To silently install Installation Manager onto a default install location on Windows:
1. Change directory to InstallerImage_win32 folder on the first installation disk.
2. Run setup.exe /S /v"/qn"

What to do next

If you want to change the install location, you can add the INSTALLDIR property inside the /v option.
For example: setup.exe /S /v"/qn INSTALLDIR=\"C:\InstallationManager\""

Silently uninstalling Installation Manager from Windows
About this task

To silently uninstall Installation Manager on Windows:

Run the following command in the command prompt: msiexec /x {DBD90D51-BD46-41AF-A1F5-
B74CEA24365B}

Installation repositories
IBM Installation Manager retrieves product packages from specified repository locations.

If the launchpad is used to start Installation Manager, the repository information is passed to Installation
Manager. If the Installation Manager is started directly, you must specify an installation repository that
contains the product packages that you want to install. See “Setting repository preferences in Installation
Manager.”

Some organizations bundle and host their own product packages on their intranet. For information about
this type of installation scenario, see the IBM Installation Manager online help. Your system
administrators will need to provide you with the correct URL.

By default, IBM Installation Manager uses an embedded URL in each Rational software development
product to connect to a repository server over the Internet. Installation Manager then searches for the
product packages as well as new features.

Setting repository preferences in Installation Manager
When you start the installation of Rational Asset Manager from the launchpad program, the location of
the repository that contains the product package you are installing is automatically defined in IBM
Installation Manager when it starts. However, if you start Installation Manager directly (for example,
installing Rational Asset Manager from a repository located on a Web server) then you must specify the
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repository preference (the URL for the directory that contains the product package) in Installation
Manager before you can install the product package. Specify these repository locations on the
Repositories page of the Preferences window. By default, Installation Manager uses an embedded URL in
each Rational software development product to connect to a repository server through the Internet and
search for installable packages and new features. Your organization may require you to redirect the
repository to use intranet sites.

Before you begin

Note: Before starting the installation process, be sure to obtain the installation package repository URL
from your administrator.

About this task

To add, edit, or remove a repository location in Installation Manager:
1. Start Installation Manager.
2. On the Start page of Installation Manager, click File → Preferences, and then click Repositories. The

Repositories page opens, showing any available repositories, their locations, and whether they are
accessible.

3. On the Repositories page, click Add Repository.
4. In the Add repository window, type the URL of the repository location or browse to it and set a file

path.
5. Click OK. If you provided an HTTPS or restricted FTP repository location, then you will be prompted

to enter a user ID and password. The new or changed repository location is listed. If the repository is
not accessible, a red x displays in the Accessible column.

6. Click OK to exit.

What to do next

Note: For Installation Manager to search the default repository locations for the installed packages,
ensure the preference Search service repositories during installation and updates on the Repositories
preference page is selected; this preference is selected by default.
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IBM Packaging Utility

Use IBM Packaging Utility software to copy product packages to a repository that can be placed on a
Web server available over HTTP or HTTPS.

Packaging Utility software is located on the Enterprise Deployment CD for each platform (Windows and
Linux) that is included with Rational Asset Manager. If you want to place a repository that contains a
Rational Asset Manager package on a Web server that will be available over HTTP or HTTPS, you must
use Packaging Utility to copy the product package of Rational Asset Manager into the repository.

Use this utility to perform the following tasks:
v Generate a new repository for product packages.
v Copy product packages to a new repository. You can copy multiple product packages into a single

repository, thereby creating a common location for your organization from which product packages can
be installed using IBM Installation Manager.

v Delete product packages from a repository.

Refer to the online help for Packaging Utility for full instructions using the tool.

Installing Packaging Utility
IBM Packaging Utility must be installed from the Enterprise Deployment CD before it can be used to
copy the Rational Asset Manager product package.

About this task

Use the following steps to install IBM Packaging Utility software from the Enterprise Deployment CD:
1. Navigate to the Enterprise Deployment CD for the appropriate platform and extract the zip file from

the CD.
2. Navigate to the Packaging Utility directory and extract the Packaging Utility installation package from

the compressed file (pu.disk_win32.zip or pu.disk_linux.zip).
3. Locate the Packaging Utility installer executable.

v For Windows: Change to the InstallerImage_win32 directory in the area where the
pu.disk_win32.zip file was unpacked. Locate the installer executable ″install.exe″.

v For Linux: Change to the InstallerImage_linux directory in the area where the pu.disk_linuz.zip file
was unpacked. Locate the installer executable ″install″.

4. Start the installer executable and follow the instructions in the wizard to install the Packaging Utility.
5. If IBM Installation Manager is not detected on your workstation, you are prompted to install it and

then the installation wizard starts. Follow the instructions in the wizard to complete the installation of
Installation Manager.

6. When the installation of Installation Manager completes, or if it is already on your computer,
Installation Manager starts and automatically begins the Install Packages wizard.

7. Follow the instructions in the Install Packages wizard to complete the installation.
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provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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Intellectual Property Dept. for Rational Software
IBM Corporation
20 Maguire Road
Lexington, Massachusetts 02421-3112
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this Documentation and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

Trademarks and service marks
The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:
v AIX
v ClearCase
v ClearQuest
v DB2
v IBM
v Passport Advantage
v Rational
v WebSphere

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other
countries.

Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the
United States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product or service names, may be trademarks or service marks of others.
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